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Copyright and Trademarks

Copyright and Trademarks

No part of this publication may be reproduced, stored in a retrieval system, or transmitted in any form or by any
means, electronic, mechanical, photocopying, recording, or otherwise, without the prior written permission of Seiko
Epson Corporation. No patent liability is assumed with respect to the use of the information contained herein. Neither
is any liability assumed for damages resulting from the use of the information herein. The information contained
herein is designed only for use with this Epson product. Epson is not responsible for any use of this information as
applied to other products.

Neither Seiko Epson Corporation nor its affiliates shall be liable to the purchaser of this product or third parties for
damages, losses, costs, or expenses incurred by the purchaser or third parties as a result of accident, misuse, or abuse of
this product or unauthorized modifications, repairs, or alterations to this product, or (excluding the U.S.) failure to
strictly comply with Seiko Epson Corporation’s operating and maintenance instructions.

Seiko Epson Corporation and its affiliates shall not be liable for any damages or problems arising from the use of any
options or any consumable products other than those designated as Original Epson Products or Epson Approved
Products by Seiko Epson Corporation.

Seiko Epson Corporation shall not be held liable for any damage resulting from electromagnetic interference that
occurs from the use of any interface cables other than those designated as Epson Approved Products by Seiko Epson
Corporation.

EPSON® is a registered trademark, and EPSON EXCEED YOUR VISION or EXCEED YOUR VISION is a trademark
of Seiko Epson Corporation.

PRINT Image Matching™ and the PRINT Image Matching logo are trademarks of Seiko Epson Corporation.
Copyright © 2001 Seiko Epson Corporation. All rights reserved.

SDXC Logo is a trademark of SD-3C, LLC.

Memory Stick Duo, Memory Stick PRO Duo, Memory Stick PRO-HG Duo, Memory Stick Micro, and MagicGate
Memory Stick Duo are trademarks of Sony Corporation.

Intel® is a registered trademark of Intel Corporation.

PowerPC® is a registered trademark of International Business Machines Corporation.

Epson Scan software is based in part on the work of the Independent JPEG Group.

libtiff

Copyright © 1988-1997 Sam Leffler
Copyright © 1991-1997 Silicon Graphics, Inc.

Permission to use, copy, modify, distribute, and sell this software and its documentation for any purpose is
hereby granted without fee, provided that (i) the above copyright notices and this permission notice
appear in all copies of the software and related documentation, and (ii) the names of Sam Leffler and
Silicon Graphics may not be used in any advertising or publicity relating to the software without the
specific, prior written permission of Sam Leffler and Silicon Graphics.
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THE SOFTWARE IS PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND, EXPRESS,
IMPLIED OR OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL,
INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES
WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER OR NOT
ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF LIABILITY, ARISING
OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

Microsoft®, Windows®, and Windows Vista® are registered trademarks of Microsoft Corporation.

Apple®, Macintosh®, Mac OS®, and OS X® are registered trademarks of Apple Inc.

ABBYY® and ABBYY FineReader® names and logos are registered trademarks of ABBYY Software House.

Adobe, Adobe Reader, Acrobat, and Photoshop are trademarks of Adobe systems Incorporated, which may be
registered in certain jurisdictions.

General Notice: Other product names used herein are for identification purposes only and may be trademarks of their
respective owners. Epson disclaims any and all rights in those marks.

© 2012 Seiko Epson Corporation. All rights reserved.
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Introduction

Where to Find Information

The latest version of the following manuals are available on the Epson support website.
http://www.epson.eu/Support (Europe)
http://support.epson.net/ (outside Europe)

❏ Start Here (paper):

Provides you with information on setting up the product and installing the software.

❏ Basic Guide (paper):

Provides you with basic information when you are using the product without a computer. This manual may not be
included depending on model and region.

❏ User’s Guide (PDF):

Provides you with detailed operating, safety, and troubleshooting instructions. See this guide when using this
product with a computer, or when using advanced features such as 2 sided copying.
To view the PDF manual, you need Adobe Acrobat Reader 5.0 or later, or Adobe Reader.

❏ Network Guide (HTML):

Provides network administrators with information on both the printer driver and network settings.

❏ Help (on the product display):

Provides basic operating and troubleshooting instructions on the product’s LCD screen. Select the Help menu on
the control panel.

Caution, Important and Note

Caution, Important, and Note in this manual are indicated as below and have the following meaning.

!Caution
must be followed carefully to avoid bodily injury.

c Important
must be observed to avoid damage to your equipment.

Note
contain useful tips and restrictions on product operation.
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Operating System Versions

In this manual, the following abbreviations are used.

❏ Windows 7 refers to Windows 7 Home Basic, Windows 7 Home Premium, Windows 7 Professional, and
Windows 7 Ultimate.

❏ Windows Vista refers to Windows Vista Home Basic Edition, Windows Vista Home Premium Edition, Windows
Vista Business Edition, Windows Vista Enterprise Edition, and Windows Vista Ultimate Edition.

❏ Windows XP refers to Windows XP Home Edition, Windows XP Professional x64 Edition, and Windows XP
Professional.

❏ Mac OS X refers to Mac OS X 10.5.x, 10.6.x, 10.7.x.

Using Epson Connect Service

Using Epson Connect and other companies’ services, you can easily print directly from your smartphone, tablet PC or
laptop, anytime and practically anywhere even across the globe! For more information about the printing and other
services, visit the following URL;
https://www.epsonconnect.com/ (Epson Connect portal site)
http://www.epsonconnect.eu (Europe only)

You can view the Epson Connect guide by double-clicking the  shortcut icon on the desktop.
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Important Instructions

Safety Instructions

Read and follow these instructions to ensure safe use of this product. Make sure you keep this guide for future
reference. Also, be sure to follow all warnings and instructions marked on the product.

❏ Use only the power cord supplied with the product and do not use the cord with any other equipment. Use of other
cords with this product or the use of the supplied power cord with other equipment may result in fire or electric
shock.

❏ Be sure your AC power cord meets the relevant local safety standard.

❏ Never disassemble, modify, or attempt to repair the power cord, plug, printer unit, scanner unit, or options by
yourself, except as specifically explained in the product’s guides.

❏ Unplug the product and refer servicing to qualified service personnel under the following conditions:
The power cord or plug is damaged; liquid has entered the product; the product has been dropped or the casing
damaged; the product does not operate normally or exhibits a distinct change in performance. Do not adjust
controls that are not covered by the operating instructions.

❏ Place the product near a wall outlet where the plug can be easily unplugged.

❏ Do not place or store the product outdoors, near excessive dirt or dust, water, heat sources, or in locations subject
to shocks, vibrations, high temperature or humidity.

❏ Take care not to spill liquid on the product and not to handle the product with wet hands.

❏ Keep this product at least 22 cm away from cardiac pacemakers. Radio waves from this product may adversely
affect the operation of cardiac pacemakers.

❏ If the LCD screen is damaged, contact your dealer. If the liquid crystal solution gets on your hands, wash them
thoroughly with soap and water. If the liquid crystal solution gets into your eyes, flush them immediately with
water. If discomfort or vision problems remain after a thorough flushing, see a doctor immediately.

❏ Avoid using a telephone during an electrical storm. There may be a remote risk of electric shock from lightning.

❏ Do not use a telephone to report a gas leak in the vicinity of the leak.

Note:
The following provides safety instructions for ink cartridges.
& “Replacing Ink Cartridges” on page 105

Product Advisories and Warnings

Read and follow these instructions to avoid damaging the product or your property. Make sure you keep this guide for
future reference.
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Setting up/using the product

❏ Do not block or cover the vents and openings in the product.

❏ Use only the type of power source indicated on the product’s label.

❏ Avoid using outlets on the same circuit as photocopiers or air control systems that regularly switch on and off.

❏ Avoid electrical outlets controlled by wall switches or automatic timers.

❏ Keep the entire computer system away from potential sources of electromagnetic interference, such as
loudspeakers or the base units of cordless telephones.

❏ The power-supply cords should be placed to avoid abrasions, cuts, fraying, crimping, and kinking. Do not place
objects on top of the power-supply cords and do not allow the power-supply cords to be stepped on or run over. Be
particularly careful to keep all the power-supply cords straight at the ends and the points where they enter and
leave the transformer.

❏ If you use an extension cord with the product, make sure that the total ampere rating of the devices plugged into
the extension cord does not exceed the cord’s ampere rating. Also, make sure that the total ampere rating of all
devices plugged into the wall outlet does not exceed the wall outlet’s ampere rating.

❏ If you plan to use the product in Germany, the building installation must be protected by a 10 or 16 amp circuit
breaker to provide adequate short-circuit protection and over-current protection for the product.

❏ When connecting the product to a computer or other device with a cable, ensure the correct orientation of the
connectors. Each connector has only one correct orientation. Inserting a connector in the wrong orientation may
damage both devices connected by the cable.

❏ Place the product on a flat, stable surface that extends beyond the base of the product in all directions. If you place
the product by the wall, leave more than 10 cm between the back of the product and the wall. The product will not
operate properly if it is tilted at an angle.

❏ When storing or transporting the product, avoid tilting it, placing it vertically, or turning it upside down;
otherwise ink may leak.

❏ Allow spaces behind the product for the cables, and space above the product so that you can fully raise the
document cover.

❏ Leave enough space in front of the product for the paper to be fully ejected.

❏ Avoid places subject to rapid changes in temperature and humidity. Also, keep the product away from direct
sunlight, strong light, or heat sources.

❏ Do not insert objects through the slots in the product.

❏ Do not put your hand inside the product or touch the ink cartridges during printing.

❏ Do not touch the white flat cable inside the product.

❏ Do not use aerosol products that contain flammable gases inside or around the product. Doing so may cause
fire.

❏ Do not move the ink cartridge holder by hand; otherwise, you may damage the product.
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❏ Always turn the product off using the P button. Do not unplug the product or turn off the power at the outlet until
the LCD screen has turned off completely.

❏ Before transporting the product, make sure that the print head is in the home (far right) position and the ink
cartridges are in place.

❏ Be careful not to trap your fingers when closing the scanner unit.

❏ If you are not going to use the product for a long period, be sure to unplug the power cord from the electrical
outlet.

❏ Do not press too hard on the scanner glass when placing the originals.

❏ During the life of your product it may be necessary to replace the waste ink pad when it has become full. Whether
and how often this is required will vary according to the number of pages you print, the type of material that you
print and the number of cleaning cycles that the product performs. Epson Status Monitor, your LCD, or lights on
the control panel will advise you when this part needs replacing. The need for replacement of the pad does not
mean that your product has ceased to operate in accordance with its specifications. The replacement of this part is
a routine product servicing activity within the product’s specification and is not a problem which requires repair.
The Epson warranty does not therefore cover the cost of this replacement. If your product needs the pad replacing
this can be performed for you by any authorised Epson service provider. It is not a user-serviceable part.

Using the product with a wireless connection

Note:
The availability of this feature varies by product.

❏ Do not use this product inside medical facilities or near medical equipment. Radio waves from this product may
adversely affect the operation of electrical medical equipment.

❏ Do not use this product near automatically controlled devices such as automatic doors or fire alarms. Radio waves
from this product may adversely affect these devices, and could lead to accidents due to malfunction.

Using memory cards

❏ Do not remove a memory card or turn off the product while the memory card light is flashing.

❏ The methods for using memory cards vary according to card type. Be sure to refer to the documentation packaged
with your memory card for details.

❏ Use only memory cards compatible with the product.
& “Memory card” on page 173

Using the LCD screen

❏ The LCD screen may contain a few small bright or dark spots, and because of its features it may have an uneven
brightness. These are normal and do not indicate that it is damaged in any way.

❏ Only use a dry, soft cloth to clean the touch panel and touchpad. Do not use liquid or chemical cleaners.
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❏ The exterior cover of the LCD screen could break if it receives a heavy impact. Contact your dealer if the panel
surface chips or cracks, and do not touch or attempt to remove the broken pieces.

❏ The touchpad is a capacitive touch panel, which responds only when touched directly with a finger. The panel may
not respond when touched with wet hand, gloved hands, or touched through a protective sheet or sticker.

❏ Press the touch panel/touchpad gently with your finger. Do not press force or operate with your nails.

❏ Do not operate by a sharp edge thing such as a ball point pen, sharp pencil, stylus pen and so on.

❏ Condensation inside the panel due to abrupt changes in temperature or humidity may cause performance to
deteriorate.

Handling ink cartridges

We will provide ink-related safety instructions and product advice/warnings in the linked section (before “Replacing
Ink Cartridges” section).

& “Replacing Ink Cartridges” on page 105

Restrictions on Copying

Observe the following restrictions in order to ensure the responsible and legal use of the product.

Copying of the following items is prohibited by law:

❏ Bank bills, coins, government-issued marketable securities, government bond securities, and municipal securities

❏ Unused postage stamps, pre-stamped postcards, and other official postal items bearing valid postage

❏ Government-issued revenue stamps, and securities issued according to legal procedure

Exercise caution when copying the following items:

❏ Private marketable securities (stock certificates, negotiable notes, checks, etc.), monthly passes, concession
tickets, etc.

❏ Passports, driver’s licenses, warrants of fitness, road passes, food stamps, tickets, etc.

Note:
Copying these items may also be prohibited by law.

Responsible use of copyrighted materials:

❏ Products can be misused by improperly copying copyrighted materials. Unless acting on the advice of a
knowledgeable attorney, be responsible and respectful by obtaining the permission of the copyright holder before
copying published material.
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Protecting Your Personal Information

This product allows you to store names and telephone numbers in its memory even when the power is turned off.

Use the following menu to erase the memory if you give the product to someone else or dispose of it.

Setup > Restore Default Settings > All Settings
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Getting to Know Your Product

Note:
The illustrations in this manual are from a similar product model. Although they may differ from your actual product, the
method of operation is the same.

Product Parts

a. ADF cover

b. Automatic Document Feeder (ADF)

c. Edge guide

d. ADF input tray (place your originals here to be copied)

e. ADF output tray (your originals are ejected here as they are copied)

f. Paper cassette 1

g. Paper cassette 2 *

* The availability of this part varies by product.
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a. Edge guides

b. Rear paper feed slot

c. Output tray

d. Output tray extension

e. Stopper

f. Edge guides

g. Paper cassette

a. Document cover

b. Scanner glass

c. Control panel

d. Memory card slots

e. Memory card light

f. External interface USB port
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a. Scanner unit

b. Ink cartridge cover

c. Ink cartridge holder

d. Print head (under the ink cartridge holder)

a. Maintenance box

b. Rear cover

c. AC inlet

d. LINE port

e. EXT. port

f. LAN port

g. USB connector

Guide to the Control Panel

Note:
❏ Control panel design varies depending on location.

❏ Although the control panel design and what displayed on the LCD screen such as menu names and option names may
differ from your actual product, the method of operation is the same.
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Button and LCD

Buttons Function

a Turns the product on or off.

b Returns to the top menu. When on the top menu, switches between the modes.

c Displays the last number dialed. When entering numbers in fax mode, this inserts a pause
symbol (-) that acts as a brief pause during dialing.

d Displays the Contacts list in fax mode.

e - LCD screen displays menus. If your product has a touch panel, you can scroll the screen by
swiping the LCD screen. Try swiping a little harder if the touch panel is slow to respond.

f Cancels/returns to the previous menu.

g l, u, r, d, OK Press l, u, r, d to select menus. Press OK to confirm the setting you have selected and go to
next screen. When typing a fax number, l acts as a backspace key, and r inserts a space.

h +, - Sets the number of copies.

i 0 - 9, *, # Specifies the date/time or the number of copies, as well as fax numbers. Enters alphanumeric
characters and switches between uppercase, lowercase, and numbers each time it is pressed.
It may be easier to use the software keypad to enter text instead of using these buttons.

j Starts printing/copying/scanning/faxing in black and white.

k Starts printing/copying/scanning/faxing in color.

l Stops the current operation or initializes the current settings.

m u, d Scrolls the screen.
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Lights

Lights Function

On when the product is on.
Flashes when the product is receiving data, printing/copying/scanning/faxing, replacing an
ink cartridge, charging ink, or cleaning the print head.

Stays on while the printer is connected to a network. Flashes while network settings are being
adjusted (green: Wi-Fi/orange: Ethernet). This light turns off in sleep mode.

Note:
For more information on the icons displayed on the LCD screen, see the Help on the control panel.
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Paper and Media Handling

Introduction to Using, Loading, and Storing Media

You can achieve good results with most types of plain paper. However, coated papers provide superior prints because
they absorb less ink.

Epson provides special papers that are formulated for the ink used in Epson ink jet products, and recommends these
papers to ensure high-quality results.

When loading special paper distributed by Epson, read the instruction sheets packed with the paper first and keep the
following points in mind.

Note:
❏ Load the paper into the paper cassette printable side down. The printable side is usually whiter or glossier. See the

instruction sheets packed with the paper for more information. Some types of paper have cut corners to help identify the
correct loading direction.

❏ If the paper is curled, flatten it or curl it slightly in the opposite direction before loading. Printing on curled paper may
cause ink to smear on your prints.

Storing paper

Return unused paper to the original package as soon as you finish printing. When handling special media, Epson
recommends storing your prints in a resealable plastic bag. Keep unused paper and prints away from high
temperature, humidity, and direct sunlight.

Selecting Paper

The following table shows supported paper types. The loading capacity, paper source, and availability of borderless
printing vary by paper as shown below.
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Media Type Size

Loading capacity (sheets)

Borderless
printing

paper
cassette 1

or 
paper

cassette

paper
cassette 2*1

rear paper
feed slot

Plain paper *2 Letter*3 up to 27.5mm up to 27.5mm 1 -

A4*3 up to 27.5mm up to 27.5mm 1 -

B5*3 up to 27.5mm up to 27.5mm 1 -

A5*3 up to 27.5mm - 1 -

A6*3 up to 27.5mm - - -

Legal*4 30 30 1 -

User defined 1 1*5 1*5 -

Thick paper Letter - - 1 -

A4 - - 1 -

B5 - - - -

A5 - - - -

Envelope #10 10 - 1 -

DL 10 - 1 -

C6 10 - - -

C4 - - 1 -

Epson Bright White Ink
Jet Paper

A4*3 200 200 1 -

Epson Photo Quality
Ink Jet Paper

A4 80 - - -

Epson Matte Paper -
Heavyweight

A4 20 - 1 ✓

Epson Photo Paper A4 20 - 1 ✓

10 × 15 cm (4 × 6 in.) 20 - - ✓

13 × 18 cm (5 × 7 in.) 20 - - ✓

Epson Premium Glossy
Photo Paper

A4 20 - 1 ✓

10 × 15 cm (4 × 6 in.) 20 - - ✓

13 × 18 cm (5 × 7 in.) 20 - - ✓

16:9 wide size
(102 × 181 mm)

20 - - ✓
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Media Type Size

Loading capacity (sheets)

Borderless
printing

paper
cassette 1

or 
paper

cassette

paper
cassette 2*1

rear paper
feed slot

Epson Premium
Semigloss Photo Paper

A4 20 - 1 ✓

10 × 15 cm (4 × 6 in.) 20 - - ✓

Epson Ultra Glossy
Photo Paper

A4 20 - 1 ✓

10 × 15 cm (4 × 6 in.) 20 - - ✓

13 × 18 cm (5 × 7 in.) 20 - - ✓

Epson Glossy Photo
Paper

A4 20 - 1 ✓

10 × 15 cm (4 × 6 in.) 20 - - ✓

13 × 18 cm (5 × 7 in.) 20 - - ✓

*1 This cassette may not be available depending on the product.

*2 Paper with a weight of 64 g/m² (17 lb) to 90 g/m² (24 lb).

*3 The loading capacity for manual 2-sided printing is 30 sheets.

*4 The loading capacity for manual 2-sided printing is 1 sheet.

*5 Availability varies depending on the paper size.

Note:
The availability of paper varies by location.

Paper type settings on the LCD screen

The product automatically adjusts itself for the type of paper you select in your print settings. That is why the paper
type setting is so important. It tells your product what kind of paper you are using and adjusts the ink coverage
accordingly. The table below lists the settings you should choose for your paper.

For this paper LCD paper type

Plain paper*1 Plain Paper

Epson Bright White Ink Jet Paper*1 Plain Paper

Epson Ultra Glossy Photo Paper Ultra Glossy

Epson Premium Glossy Photo Paper Prem. Glossy

Epson Premium Semigloss Photo Paper Prem. Glossy

Epson Glossy Photo Paper Glossy

Epson Photo Paper Photo Paper

Epson Matte Paper – Heavyweight Matte
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For this paper LCD paper type

Epson Photo Quality Ink Jet Paper Matte

*1 You can perform 2-sided printing with this paper.

Paper type settings from the printer driver

The product automatically adjusts itself for the type of paper you select in your print settings. That is why the paper
type setting is so important. It tells your product what kind of paper you are using and adjusts the ink coverage
accordingly. The table below lists the settings you should choose for your paper.

For this paper Printer driver paper type

Plain paper* plain papers

Epson Bright White Ink Jet Paper* plain papers

Epson Ultra Glossy Photo Paper* Epson Ultra Glossy

Epson Premium Glossy Photo Paper* Epson Premium Glossy

Epson Premium Semigloss Photo Paper* Epson Premium Semigloss

Epson Glossy Photo Paper* Epson Glossy

Epson Photo Paper* Epson Photo

Epson Matte Paper – Heavyweight* Epson Matte

Thick paper* Thick-Paper

Epson Photo Quality Ink Jet Paper* Epson Matte

Envelopes Envelope

* These paper types are compatible with Exif Print and PRINT Image Matching. For more information, refer to the documentation
that came with the Exif Print or PRINT Image Matching compatible digital camera.

Note:
The availability of special media varies by location. For the latest information on media available in your area, contact
Epson support.
& “Technical Support Web Site” on page 179
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Loading Paper into the Paper Cassette

Follow these steps to load paper:

a. Paper cassette 1
b. Paper cassette 2*

* The availability of this part varies by product.

A Pull out the paper cassette.

Note:
If the output tray has been ejected, close it before pulling out the paper cassette.
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B Pinch and slide the edge guides to the sides of the paper cassette.

Note:
When using Legal size paper, extend the paper cassette as shown in the illustration.

C Slide the edge guide to adjust to the paper size you will use.
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D Load paper toward the edge guide with printable side face down, and check that the paper is not sticking out
from the end of the cassette.

Note:
❏ Paper cassette 2 supports plain paper size B5 or larger only.

❏ Fan and align the edges of the paper before loading.

E Slide the edge guides to the edges of the paper.
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Note:
For plain paper, do not load paper above the H arrow mark inside the edge guide.
For Epson special media, make sure the number of sheets is less than the limit specified for the media.

& “Selecting Paper” on page 20

F Keep the cassette flat and slowly and carefully reinsert it all the way into the product.

G Slide out the output tray and raise the stopper.

Note:
❏ If you want to print on commercially available pre-punched paper, see “Loading Paper and Envelopes into the Rear

Paper Feed Slot” on page 31.

❏ Leave enough space in front of the product for the paper to be fully ejected.

❏ Do not remove or insert the paper cassette while the product is operating.

Loading Envelopes into the Paper Cassette

Follow these steps to load envelopes:
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A Pull out the paper cassette 1.

Note:
If the output tray has been ejected, close it before pulling out the paper cassette.

B Pinch and slide the edge guides to the sides of the paper cassette.
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C Load envelopes lengthwise with the flap facing up and to the right.

Note:
Make sure the number of envelopes does not exceed the limit.

& “Selecting Paper” on page 20

D Slide the edge guides to the edges of the envelopes and check that the envelopes are not sticking out from the end
of the cassette.

Note:
Even if you do not feel a click, slide the edge guides to the edges of the envelopes.
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E Keep the cassette flat and slowly and carefully reinsert it all the way into the product.

F Slide out the output tray and raise the stopper.

Note:
❏ The thickness of envelopes and their ability to fold vary widely. If the total thickness of the stack of envelopes

exceeds 10mm, press down on the envelopes to flatten them before loading. If print quality declines when a stack
of envelopes is loaded, load one envelope at a time.

❏ Do not use envelopes that are curled or folded.

❏ Flatten the envelope and the flaps before loading.

❏ Flatten the leading edge of the envelope before loading.

❏ Avoid using envelopes that are too thin, as they may curl during printing.

❏ Align the edges of the envelopes before loading.
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Loading Paper and Envelopes into the Rear Paper Feed
Slot

Note:
Printing using the rear paper feed slot is only available when printing from a computer. To copy and print without a
computer, load paper in the paper cassette.

Follow the steps below to load paper and envelopes into the rear paper feed slot:

A Slide out the output tray, and raise the stopper.

B Open the rear paper feed slot.

C While holding only one sheet of paper with the printable side face-up at the center of the rear paper feed slot,
slide the edge guides until they are flush with the edges of the paper.
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Note:
The printable side is often whiter or brighter than the other side.

D Insert the paper into the rear paper feed slot. The paper is automatically fed.

Note:
❏ You can use the following sizes of paper with binding holes: A4, A5, Legal, Letter. Automatic 2-sided printing is

not available.

❏ When loading envelopes, load the short edge first with the flap facing down.

❏ Do not use envelopes that are curled or folded.

❏ Flatten the envelope and the flaps before loading.

❏ Flatten the leading edge of the envelope before loading.

❏ Avoid using envelopes that are too thin, as they may curl during printing.

Placing Originals

Automatic Document Feeder (ADF)

You can load your original documents in the Automatic Document Feeder (ADF) to copy, scan, or fax multiple pages
quickly. The ADF can scan both sides of your documents. To do so, select the option in the copy setting menu. You can
use the following originals in the ADF.

Size A4/Letter/Legal

Type Plain paper
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Weight 64 g/m2 to 95 g/m2

Capacity 30 sheets or 3 mm or less (A4, Letter)/10 sheets (Legal)

When you scan a 2-sided document using the ADF, legal size paper is not available.

c Important:
To prevent paper jams, avoid the following documents. For these types, use the scanner glass.

❏ Documents held together with paper clips, staples, etc.

❏ Documents that have tape or paper stuck to them.

❏ Photos, OHPs, or thermal transfer paper.

❏ Paper that is torn, wrinkled, or has holes.

A Tap the originals on a flat surface to even the edges.

B Slide the edge guide on the Automatic Document Feeder.

C Insert the originals face-up and short edge first into the Automatic Document Feeder.
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D Slide the edge guide until it is flush with the originals.

Note:
❏ For 2-up Copy layout, place the original as shown. Make sure the orientation of the original matches the Document

Orientation settings.

❏ When you use the copy function with the Automatic Document Feeder (ADF), the print settings are fixed at Reduce/
Enlarge - Actual Size, Paper Type - Plain Paper, and Paper Size - A4/Legal. The print is cropped if you copy an original
larger than A4.
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Scanner glass

A Open the document cover and place your original face-down on the scanner glass.

B Slide the original to the corner.

Note:
See the following sections if any problems occur with the scanning area or the scanning direction when using EPSON
Scan.

& “The edges of your original are not scanned” on page 164 
& “Multiple documents are scanned into a single file” on page 165

C Close the cover gently.

Note:
When there is a document in the Automatic Document Feeder (ADF) and on the scanner glass, priority is given to the
document in the Automatic Document Feeder (ADF).

Inserting a Memory Card

You can print photos that are stored on a memory card, or save scanned data on a memory card. The following
memory cards are supported.
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SD, miniSD, microSD, SDHC, miniSDHC, microSDHC, SDXC, microSDXC, MultiMediaCard, MMCplus,
MMCmobile, MMCmicro, Memory Stick Duo, Memory Stick PRO Duo, Memory Stick PRO-HG Duo, Memory Stick
Micro, MagicGate Memory Stick Duo

c Important:
The following memory cards require an adapter. Attach it before inserting the card into the slot, otherwise the card
may get stuck.

❏ miniSD, microSD, miniSDHC, microSDHC, microSDXC, MMCmicro

❏ MMCmobile

❏ Memory Stick Micro

A Insert one card at a time.

B Check the light stays on.
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 = on,  = flashing

c Important:
❏ Do not try to force the card all the way into the slot. It should not be fully inserted.

❏ Do not remove the memory card while the light is flashing. The data in the memory card may be lost.

Note:
❏ If you have more than 999 images on your memory card, images are automatically divided into groups and the

group selection screen is displayed. Select the group that contains the image you want to print. Images are sorted
by the date they were taken.

❏ To select another group for WF-3520/WF-3530 series, remove and reinsert the memory card, and then select the
group.

❏ To select another group for WF-3540 series, select More Functions > Print Photos > Select Location > Select
Folder or Select Group.
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Copying

Copying Documents

Basic copying

Follow the steps below to copy documents. For products with two paper cassettes, if you want to copy a large quantity
of documents in a single batch, load A4/Legal plain paper in both cassettes and set the Paper Source to Cassette
1>Cassette 2 in step 7.

A Load paper in the paper cassette.
& “Loading Paper into the Paper Cassette” on page 24

B Place original.
& “Placing Originals” on page 32

C Enter Copy mode from the Home menu.

D Press + and - to set the number of copies.

E Set the density.

F Press d to enter the Copy menu.

G Select the appropriate copy settings such as paper size, paper type, and paper quality.

Note:
❏ Depending on the model, you can make copy settings in Paper and Copy Settings.

❏ You can preview the copy results before you start copying.

❏ You can make various layout copies such as 2-sided copy, 2-up copy, and so on. Change the 2-sided or layout
settings as necessary.

H Press one of the x buttons to set the color mode, and then start copying.

2-Sided copying

With duplex copying, you can create double-sided or single-sided copies from double-sided or single-sided originals.
Follow the instructions below to perform duplex copying.

A Load paper in the cassette.
& “Loading Paper into the Paper Cassette” on page 24
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B Place original.
& “Placing Originals” on page 32

C Enter Copy mode from the Home menu.

D Press + and - to set the number of copies.

E Set the density.

F Press d to enter the Copy menu.

Note:
Depending on the model, you can make copy settings in Paper and Copy Settings.

G Select 2-Sided Copying.

H Select the type of 2-sided copying.

Setting Description

1>1-Sided Normal copying.

2>2-Sided Each side of a double-sided original is printed onto each side of a single sheet of paper.

1>2-Sided Two single-sided originals are printed onto each side of a single sheet of paper.

2>1-Sided Each side of a double-sided original is printed onto one side of a single sheet of paper.

I Make the appropriate settings for Document Orientation, Binding Direction, or Binding Margin.

Setting Description

Document Orientation Specifies the orientation of your originals.

Binding Direction Specifies the binding direction of your originals.

Binding Margin Specifies the binding direction of your prints.

Note:
Depending on the settings for 2-Sided Copying and Layout, these menus may not be available.

J Press one of the x buttons to set the color mode, and then start copying.

Collate copying

With the collate copying function, multiple copies of multiple pages in a document are printed in order and collated by
copy set. Follow the instructions below to perform collated copying.
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A Load paper in the cassette.
& “Loading Paper into the Paper Cassette” on page 24

B Place original.
& “Placing Originals” on page 32

C Enter Copy mode.

D Press + and - to set the number of copies.

E Set the density.

F Press d to enter the Copy menu.

Note:
Depending on the model, you can make copy settings in Paper and Copy Settings.

G Select Collate Copy.

H Select On.

I Press one of the x buttons to set the color mode, and then start copying.

Layout copying

With the layout function, you can copy two single-sided originals onto a single page.

A Load paper in the cassette.
& “Loading Paper into the Paper Cassette” on page 24

B Place original.
& “Placing Originals” on page 32

C Enter Copy mode from the Home menu.

D Press d to enter the Copy menu.

Note:
Depending on the model, you can make copy settings in Paper and Copy Settings.

E Select Layout.
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F Select A4, 2-up Copy.

G Press one of the x buttons to set the color mode, and then start copying.

Copy Mode Menu List

Refer to the section below for the Copy mode menu list.
& “Copy Mode” on page 97
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Printing

Printer Driver and Status Monitor

The printer driver lets you choose from a wide variety of settings to get the best printing results. The status monitor and
the printer utilities help you check the product and keep it in top operating condition.

Note for Windows users:
❏ Your printer driver automatically finds and installs the latest version of the printer driver from Epson’s Web site. Click

the Software Update button in your printer driver’s Maintenance window, and then follow the on-screen instructions.
If the button does not appear in the Maintenance window, point at All Programs or Programs in the Windows Start
menu, and check in the EPSON folder.

❏ If you want to change the language of the driver, select the language you want to use from the Language setting in your
printer driver’s Maintenance window. Depending on the location, this function may not be available.

Accessing the printer driver for Windows

You can access the printer driver from most Windows applications, the Windows Start menu, or the taskbar.

To make settings that apply only to the application you are using, access the printer driver from that application.

To make settings that apply to all of your Windows applications, access the printer driver from the Start menu or the
taskbar.

Refer to the following sections to access the printer driver.

Note:
Screen shots of the printer driver windows in this User’s Guide are from Windows 7.

From Windows applications

A Click Print or Print Setup on the File menu.

B In the window that appears, click Printer, Setup, Options, Preferences, or Properties. (Depending on your
application, you may need to click one or a combination of these buttons.)

From the Start menu

❏ Windows 7:
Click the start button, select Devices and Printers. Then right-click the product and select Printing
preferences.

❏ Windows Vista:
Click the start button, select Control Panel, and then select Printer from the Hardware and Sound category.
Then select the product and then click Select printing preferences.
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❏ Windows XP:
Click Start, Control Panel, (Printers and Other Hardware,) then Printers and Faxes. Select the product, then
click Printing Preferences on the File menu.

From the shortcut icon on the taskbar

Right-click the product icon on the taskbar, then select Printer Settings.

To add a shortcut icon to the Windows taskbar, first access the printer driver from the Start menu as described above.
Next, click the Maintenance tab, and then the Monitoring Preferences button. In the Monitoring Preferences
window, select the Shortcut Icon check box.

Getting information through online help

In the printer driver window, try one of the following procedures.

❏ Right-click the item, then click Help.

❏ Click the  button at the top right of the window, then click the item (for Windows XP only).

Accessing the printer driver for Mac OS X

The table below describes how to access the printer driver dialog.

Dialog Box How to Access It

Page Setup Click Page Setup on the File menu of your application.

Note:
Depending on your application, the Page Setup menu may not appear in the File menu.

Print Click Print on the File menu of your application.

Epson Printer
Utility 4

For Mac OS X 10.7, click System Preferences on the Apple menu and then click Print & Scan.
Select your product from the Printers list box, click Options & Supplies, Utility, and then click
Open Printer Utility.

For Mac OS X 10.6, click System Preferences on the Apple menu and then click Print & Fax.
Select your product from the Printers list box, click Options & Supplies, Utility, and then click
Open Printer Utility.

For Mac OS X 10.5, click System Preferences on the Apple menu and then click Print & Fax.
Select your product from the Printers list box, click Open Print Queue and then click Utility
button.

Getting information through online help

Click the  Help button in the Print dialog box.
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Basic Operations

Basic printing

Note:
❏ The screen shots in this section may vary depending on the model.

❏ Before you print, load paper properly.
& “Loading Paper into the Paper Cassette” on page 24 
& “Loading Envelopes into the Paper Cassette” on page 27 
& “Loading Paper and Envelopes into the Rear Paper Feed Slot” on page 31

❏ Refer to the section below for the printable area.
& “Printable area” on page 170

❏ After completing the settings, print one test copy and examine the results before printing an entire job.

Basic product settings for Windows

A Open the file you want to print.

B Access the printer settings.
& “Accessing the printer driver for Windows” on page 42

C Click the Main tab.

D Select the appropriate Paper Source setting.
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E Select the appropriate Document Size setting. You can also define a custom paper size. For details, see the online
help.

F Check Borderless to print borderless photos.
& “Selecting Paper” on page 20

If you want to control the amount of the image that extends beyond the edges of the paper, click the Settings
button, select Auto Expand as the Method of Enlargement, and then adjust the Amount of Enlargement
slider.

G Select Portrait (tall) or Landscape (wide) to change the orientation of your print.

Note:
Select Landscape when printing on envelopes.

H Select the appropriate Paper Type setting.
& “Paper type settings from the printer driver” on page 23

Note:
Print quality is automatically adjusted for the selected Paper Type.

I Click OK to close the printer settings window.

Note:
To make changes to advanced settings, refer to the relevant section.

J Print your file.

Basic product settings for Mac OS X

Note:
❏ Screen shots of the printer driver windows in this section are from Mac OS X 10.7.

❏ When printing envelopes, use the application to rotate the data 180 degrees.

A Open the file you want to print.
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B Access the Print dialog box.
& “Accessing the printer driver for Mac OS X” on page 43

Note:
If the simplified status monitor is displayed, click the Show Details button (for Mac OS X 10.7) or the d button (for
Mac OS X 10.6 or 10.5) to extend this dialog box.

C Select the product you are using as the Printer setting.

Note:
Depending on your application, you may not be able to select some of the items in this dialog box. If so, click Page
Setup on the File menu of your application, and then make suitable settings.

D Select the appropriate Paper Size setting.

Note:
Select XXX (Borderless) as the Paper Size if you want to print borderless photos.
& “Selecting Paper” on page 20

E Select the appropriate Orientation setting.

Note:
Select landscape orientation when printing envelopes.
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F Select Print Settings from the pop-up menu.

G Select the appropriate Paper Source setting.

H Select the appropriate Media Type setting.
& “Paper type settings from the printer driver” on page 23

I Select the appropriate Expansion setting during borderless printing to control the amount of the image that
extends beyond the edges of the paper.

J Click Print to start printing.

Canceling printing

If you need to cancel printing, follow the instructions in the appropriate section below.

Using the product button

Press y to cancel a print job in progress.

For Windows

Note:
You cannot cancel a print job that has been completely sent to the product. In this case, cancel the print job by using the
product.
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A Access the EPSON Status Monitor 3.
& “For Windows” on page 137

B Click the Print Queue button. The Windows Spooler appears.

C Right-click on the job you want to cancel and then select Cancel.

For Mac OS X

Follow the steps below to cancel a print job.

A Click your product icon in the Dock.

B In the Document Name list, select the document which is printing.

C Click the Delete button to cancel the print job.

Other Options

Printing photos the easy way

Epson Easy Photo Print lets you lay out and print digital images on various types of paper. The step-by-step
instructions in the window let you preview the printed images and get the effects you want without having to make any
difficult settings.
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Using the Quick Print function, you can perform one-click printing with the settings you make.

Starting Epson Easy Photo Print

For Windows
❏ Double-click the Epson Easy Photo Print icon on the desktop.

❏ For Windows 7 and Vista:
Click the start button, point to All Programs, click Epson Software, and then click Easy Photo Print.

For Windows XP:
Click Start, point to All Programs, point to Epson Software, then click Easy Photo Print.

For Mac OS X
Double-click the Applications folder on your Mac OS X hard drive, then double-click in turn on the Epson Software
and Easy Photo Print folders and finally double-click the Easy Photo Print icon.

Product presets (For Windows Only)

Printer driver presets make printing a snap. You can also create presets of your own.

Product settings for Windows

A Access the printer settings.
& “Accessing the printer driver for Windows” on page 42

B Select a Printing Presets in the Main tab. Product settings are automatically set to the values displayed in the
pop-up window.

2-sided printing

Use the printer driver to print on both sides of the paper.

For Windows users:
Four types of 2-sided printing are available: automatic standard, automatic folded booklet, manual standard and
manual folded booklet.
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For Mac OS X users:
Mac OS X supports automatic standard 2-sided printing only.

2-sided printing is only available for the following papers and sizes.

Paper Size

Plain paper Legal*, Letter, A4, B5, A5*, A6*

Epson Bright White Ink Jet Paper A4

* Manual 2-sided printing only.

Note:
❏ This feature may not be available at some settings.

❏ Manual 2-sided printing may not be available when the product is accessed over a network or is used as a shared
printer.

❏ If the ink runs low during automatic 2-sided printing, the product stops printing and the ink needs to be replaced. When
ink replacement is complete, the product starts printing again, but there may be some missing parts in your print. If this
happens, print again the page that has missing parts.

❏ The loading capacity differs during 2-sided printing.
& “Selecting Paper” on page 20

❏ Only use papers that are suitable for 2-sided printing. Otherwise, the printout quality may deteriorate.

❏ Depending on the paper and the amount of ink used to print text and images, ink may bleed through to the other side of
the paper.

❏ The surface of the paper may be smeared during 2-sided printing.

Note for Windows:
❏ Manual 2-sided printing is available only when EPSON Status Monitor 3 is enabled. To enable the status monitor,

access the printer driver and click the Maintenance tab followed by the Extended Settings button. In the Extended
Settings window, check the Enable EPSON Status Monitor 3 check box.

❏ When automatic 2-sided printing is performed, printing may be slow depending on the combination of options selected
for Select Document Type in the Print Density Adjustment window and for Quality in the Main window.

Note for Mac OS X:
When automatic 2-sided printing is performed, printing may be slow depending on the setting the Document Type setting in
Two-sided Printing Settings.

Product settings for Windows

A Access the printer settings.
& “Accessing the printer driver for Windows” on page 42

B Select 2-Sided Printing check box.

Note:
When using automatic printing, make sure the Auto check box is checked.
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C Click Settings, and make the appropriate settings.

Note:
If you want to print a folded booklet, select Booklet.

D Check the other settings and print.

Note:
❏ When printing automatically, and if you are printing high-density data such as photos or graphs, we

recommend making the settings in the Print Density Adjustment window.

❏ The actual binding margin may be different from the specified settings depending on your application.
Experiment with a few sheets to examine actual results before printing the entire job.

❏ Manual 2-sided printing allows you to print the even-numbered pages first. When you print odd-numbered
pages, a blank sheet of paper is output at the end of the print job.

❏ When you are printing manually, make sure that the ink is completely dry before reloading the paper.

Product settings for Mac OS X

A Access the Print dialog box.
& “Accessing the printer driver for Mac OS X” on page 43

B Make the appropriate settings in the Two-sided Printing Settings pane.

C Check the other settings and print.

Note:
If you are printing high-density data such as photos or graphs, we recommend adjusting Print Density and Increased
Ink Drying Time settings manually.

Fit to page printing

Lets you automatically enlarge or reduce the size of your document to fit the paper size selected in the printer driver.
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Note:
This feature may not be available at some settings.

Product settings for Windows

A Access the printer settings.
& “Accessing the printer driver for Windows” on page 42

B Select Reduce/Enlarge Document and Fit to Page in the More Options tab, and then select the size of the paper
you are using from Output Paper.

C Check the other settings and print.

Product settings for Mac OS X

A Access the Print dialog box.
& “Accessing the printer driver for Mac OS X” on page 43

B Choose Scale to fit paper size for Destination Paper Size in the Paper Handling pane and select the desired
paper size from the pop-up menu.

C Check the other settings and print.
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Pages per Sheet printing

Lets you use the printer driver to print two or four pages on a single sheet of paper.

Note:
This feature may not be available at some settings.

Product settings for Windows

A Access the printer settings.
& “Accessing the printer driver for Windows” on page 42

B Select 2-Up or 4-Up as Multi-Page in the Main tab.

C Click Page Order, and make the appropriate settings.

D Check the other settings and print.

Product settings for Mac OS X

A Access the Print dialog box.
& “Accessing the printer driver for Mac OS X” on page 43

B Select the desired number of Pages per Sheet and the Layout Direction (page order) in the Layout pane.

C Check the other settings and print.
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Sharing the Product for Printing

Setup for Windows

These instructions tell you how to set up your product so other users on the network can share it.

First you will set up the product as a shared printer on the computer directly connected to it. Then you will add the
product to each network computer that will access it.

Note:
❏ These instructions are for small networks only. To share the product on a large network, consult your network

administrator.

❏ The screen shots in the following section are from Windows 7.

Setting up the product as a shared printer

Note:
❏ To set up the product as a shared printer in Windows 7 or Vista, you will need an account with administrator privileges

and the password if you log on as a standard user.

❏ To set up the product as a shared printer in Windows XP, you must log on to a Computer Administrator account.

Follow the steps below on the computer that is connected directly to the product:

A Windows 7:
Click the start button, select Devices and Printers.

Windows Vista:
Click the start button, select Control Panel, and then select Printer from the Hardware and Sound category.

Windows XP:
Click Start and select Control Panel, and then select Printers and Faxes, from the Printers and Other
Hardware category.

B Windows 7:
Right-click the icon for your product, click Printer properties, and then click Sharing. Then click the Change
Sharing Options button.

Windows Vista:
Right-click the icon for your product, and then click Sharing. Click the Change sharing options button and
then click Continue.

Windows XP:
Right-click the icon for your product, then click Sharing.

C Select Share this printer, then type a Share name.

Note:
Do not use spaces or hyphens in the share name.
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If you want to automatically download printer drivers for computers that are running different versions of
Windows, click Additional Drivers and select the environment and the operating systems of the other
computers. Click OK, then insert the product software disk.

D Click OK or Close (if you installed additional drivers).

Adding the product to the other network computers

Follow these steps to add the product to each network computer that will access it.

Note:
Your product must be set up as a shared printer on the computer to which it is connected before you can access it from
another computer.
&  “Setting up the product as a shared printer” on page 54.

A Windows 7:
Click the start button, select Devices and Printers.

Windows Vista:
Click the start button, select Control Panel, and then select Printer from the Hardware and Sound category.

Windows XP:
Click Start and select Control Panel, and then select Printers and Faxes, from the Printers and Other
Hardware category.
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B Windows 7 and Vista:
Click the Add a printer button.

Windows XP:
Click the Add a printer button. The Add Printer Wizard appears. Click the Next button.

C Windows 7 and Vista:
Click Add a network, wireless or Bluetooth printer, and then click Next.

Windows XP:
Select A network printer, or a printer attached to another computer, then click Next.

D Follow the on-screen instructions to select the product you want to use.

Note:
Depending on the operating system and the configuration of the computer to which the product is connected, the Add Printer
Wizard may prompt you to install the printer driver from the product software disk. Click the Have Disk button and follow
the on-screen instructions.

Setup for Mac OS X

To set up your product on a Mac OS X network, use the Printer Sharing setting. See your Macintosh documentation for
details.
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Scanning

Let’s Try Scanning

Starting a Scan

Let’s scan a document to get used to the process.

A Place your document.
& “Placing Originals” on page 32

B Start Epson Scan.

❏ Windows:
Double-click the Epson Scan icon on the desktop.

❏ Mac OS X:
Select Applications > Epson Software > EPSON Scan.

C Select Home Mode.

     User’s Guide

Scanning

57



D Select Text/Line Art as the Document Type setting.

E Click Preview.

F Click Scan.
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G Click OK.

Your scanned image is saved.

Image Adjustment Features

Epson Scan offers a variety of settings for improving color, sharpness, contrast, and other aspects affecting image
quality.

See the Help for more details on Epson Scan.

Histogram Provides a graphical interface for adjusting highlight, shadow, and gamma levels
individually.

Tone Correction Provides a graphical interface for adjusting tone levels individually.
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Image Adjustment Adjusts brightness and contrast and the balance of red, green, and blue colors in the
overall image.

Color Palette Provides a graphical interface for adjusting mid-tone levels, such as skin tones, without
affecting the highlight and shadow areas of the image.

Unsharp Mask Sharpens the edges of image areas for an overall clearer image.

Descreening Removes rippled patterns (known as moiré) that can appear in subtly shaded image areas
such as skin tones.

Color Restoration Restores the colors in faded photos automatically.
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Backlight Correction Removes shadows from photos that have too much background light.

Dust Removal Removes dust marks from your originals automatically.

Text Enhancement Enhances text recognition when scanning text documents.

Auto Area Segmentation Makes Black&White images clearer and text recognition more accurate by separating the
text from the graphics.

Color Enhance Enhance a certain color. You can select from red, blue, or green.

Basic Scanning from the Control Panel

You can scan documents and send the scanned image from the product to a connected computer.

     User’s Guide

Scanning

61



Note:
For information on Scan to Cloud, see the Epson Connect guide, which can be accessed using the shortcut icon  on the
desktop.

A Place your original(s).
& “Placing Originals” on page 32

B Select Scan from the Home menu.

C Select a scan menu items.

& “Scan Mode” on page 99

D If you select Scan to PC, select a computer.
If you select Scan to Memory Card, make settings such as the scan format and 2-sided settings.

E Press the x buttons to start scanning.

Your scanned image is saved.

Scan mode menu list

Refer to the section below for the Scan mode menu list.
& “Scan Mode” on page 99

Basic Scanning from Your Computer

Scanning in Home Mode

Home Mode lets you customize some scanning settings and check the changes you have made in a preview image. This
mode is useful for basic scanning of photos and graphics.

Note:
❏ In Home Mode, you can only scan from the scanner glass.

❏ See the Help for more details on Epson Scan.

A Place your original(s).
& “Scanner glass” on page 35

B Start Epson Scan.
& “Starting Epson Scan Driver” on page 76
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C Select Home Mode from the Mode list.

D Select the Document Type setting.

E Select the Image Type setting.

F Click Preview.
& “Previewing and Adjusting the Scan Area” on page 67

G Adjust the exposure, brightness, and other image quality settings.

H  Click Scan.

I  In the File Save Settings window, select the Type setting and then click OK.

Note:
If the Show this dialog box before next scan check box is cleared, Epson Scan starts scanning immediately without
displaying the File Save Settings window.

Your scanned image is saved.
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Scanning in Office Mode

Office Mode lets you quickly scan text documents without previewing your image.

Note:
See the Help for more details on Epson Scan.

A Place your original(s).
& “Placing Originals” on page 32

Note for the Automatic Document Feeder (ADF):
Do not load paper above the line just under the d arrow mark on the ADF.

B Start Epson Scan.
& “Starting Epson Scan Driver” on page 76

C Select Office Mode from the Mode list.

D Select the Image Type setting.

E Select the Document Source setting.
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F Select the size of your original as the Size setting.

G Select an appropriate resolution for your original(s) as the Resolution setting.

H Click Scan.

I In the File Save Settings window, select the Type setting and then click OK.

Note:
If the Show this dialog box before next scan check box is cleared, Epson Scan starts scanning immediately without
displaying the File Save Settings window.

Your scanned image is saved.

Scanning in Professional Mode

Professional Mode gives you total control of your scanning settings and lets you check the changes you have made in a
preview image. This mode is recommended for advanced users.

Note:
See the Help for more details on Epson Scan.

A Place your original(s).
& “Placing Originals” on page 32

B Start Epson Scan.
& “Starting Epson Scan Driver” on page 76
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C Select Professional Mode from the Mode list.

D Select the type of original(s) you are scanning as the Document Type setting.

E Select the Document Source setting.

F If you select Reflective as the Document Type setting, select Photo or Document as the Auto Exposure Type
setting.

G Select the Image Type setting.

H Select an appropriate resolution for your original(s) as the Resolution setting.
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I Click Preview to preview your image(s). The Preview window opens and displays your image(s).
& “Previewing and Adjusting the Scan Area” on page 67

Note for the Automatic Document Feeder (ADF):
❏ The ADF loads your first document page, and then Epson Scan prescans it and displays it in the Preview

window. The ADF then ejects your first page.
Place your first document page on top of the rest of the pages, and then load the entire document into the ADF.

❏ Do not load paper above the line just under the d arrow mark on the ADF.

J Select the size of the scanned image(s) as the Target Size setting if necessary. You can scan your images at their
original size, or you can reduce or enlarge their size by selecting Target Size.

K Adjust the image quality if necessary.
& “Image Adjustment Features” on page 59

Note:
You can save the settings you make as a group of custom settings with a Name, and later apply these custom settings
when scanning. Your custom settings are also available in Epson Event Manager.

See the Help for more details on Epson Event Manager.

L  Click Scan.

M  In the File Save Settings window, select the Type setting and then click OK.

Note:
If the Show this dialog box before next scan check box is cleared, Epson Scan starts scanning immediately without
displaying the File Save Settings window.

Your scanned image is saved.

Previewing and Adjusting the Scan Area

Selecting a preview mode

Once you have selected your basic settings and resolution, you can preview your image and select or adjust the image
area in a Preview window. There are two types of preview.

❏ Normal preview displays your previewed image(s) in their entirety. You can select the scan area and make any
image quality adjustments manually.

❏ Thumbnail preview displays your previewed image(s) as thumbnail(s). Epson Scan automatically locates the
edges of your scan area, applies automatic exposure settings to the image(s), and rotates the image(s) if necessary.
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Note:
❏ Some of the settings that you change after previewing an image are reset if you change the preview mode.

❏ Depending on your document type and the Epson Scan mode you are using, you may not be able to change the preview
type.

❏ If you preview image(s) without the Preview dialog displayed, image(s) are displayed in the default preview mode. If you
preview with the Preview dialog displayed, image(s) are displayed in the preview mode that was displayed just before
previewing.

❏ To resize the Preview window, click and drag the corner of the Preview window.

❏ See the Help for more details on Epson Scan.

Creating a marquee

A marquee is a moving dotted line that appears on the edges of your preview image to indicate the scan area.

Do one of the following to draw a marquee.

❏ To draw the marquee manually, position the pointer in the area where you want to place the corner of your
marquee and click. Drag the cross-hairs over the image to the opposite corner of the desired scan area.

❏ To draw the marquee automatically, click the  auto locate icon. You can only use this icon when you are
viewing a normal preview and you only have one document on the scanner glass.

❏ To draw the marquee at a specified size, type in a new width and height in the Document Size setting.

❏ For best results and image exposure, make sure all sides of the marquee are located inside the preview image. Do
not include any areas around the preview image in the marquee.

Adjusting a marquee

You can move the marquee and adjust its size. If you are viewing a normal preview, you can create multiple marquees
(up to 50) on each image to scan different image areas as separate scan files.

To move the marquee, position your cursor inside the marquee. The pointer becomes a hand. Click
and drag the marquee to the desired location.
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To resize the marquee, position your cursor over the edge or corner of the marquee.

The pointer becomes a straight or angled double-arrow. Click and drag the edge or corner to the
desired size.

To create additional marquees of the same size, click this icon.

To delete a marquee, click inside the marquee and click this icon.

To activate all marquees, click this icon.

Note:
❏ To restrict the movement of the marquee to vertical or horizontal only, hold down the Shift key as you move the

marquee.

❏ To restrict the size of the marquee to the current proportions, hold down the Shift key as you resize the marquee.

❏ If you draw multiple marquees, make sure you click All in the Preview window before you scan. Otherwise, only the area
inside the last marquee you drew will be scanned.
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Various Types of Scanning

Scanning a Magazine

First of all, place your magazine and start Epson Scan.
& “Starting a Scan” on page 57

A Select Home Mode from the Mode list.

B Select Magazine as the Document Type setting.

C Click Preview.

D Adjust the exposure, brightness, and other image quality settings.

See the Help for more details on Epson Scan.
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E Click Scan.

F Select PDF as the Type setting, and then click OK.

Your scanned image is saved.
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Scanning Multiple Documents to a PDF File

First of all, place your document and start Epson Scan.
& “Starting a Scan” on page 57

A Select Professional Mode from the Mode list.

B Select the Document Source setting.
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C Click Preview.

Note for the Automatic Document Feeder (ADF):
❏ The document page ejected by the ADF has not been scanned yet. Reload the entire document into the ADF.

❏ Do not load paper above the line just under the d arrow mark on the ADF.

D Adjust the exposure, brightness, and other image quality settings.

See the Help for more details on Epson Scan.

E Click Scan.

F Select PDF as the Type setting, and then click OK.

Note:
If the Show Add Page dialog after scanning check box is cleared, Epson Scan automatically saves your document
without displaying the Add Page Confirmation window.
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G Epson Scan starts scanning your document.

H If you want to scan more pages, click Add page.
Load the document and scan again, repeating as necessary for each page.

If you have finished scanning, go to step 9.

I Click Edit page or Save File.

Edit page Select this button if you want to delete or reorder any of the pages. Then use the icons on the
bottom of the Editing Page window to select, rotate, reorder, and delete pages.
See the Help for more details on Epson Scan.

Click OK when you are finished editing your pages.

Save File Select this button when you are finished.

The pages are saved in one PDF file.
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Scanning a Photo

First of all, place your photo on the scanner glass and start Epson Scan.
& “Starting a Scan” on page 57

A Select Home Mode from the Mode list.

B Select Photograph as the Document Type setting.

C Click Preview.

D Adjust the exposure, brightness, and other image quality settings.

See the Help for more details on Epson Scan.
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E Click Scan.

F Select JPEG as the Type setting, and then click OK.

Your scanned image is saved.

Software Information

Starting Epson Scan Driver

This software lets you control all aspects of scanning. You can use this as a standalone scanning program or use it with
another TWAIN-compliant scanning program.

How to start

❏ Windows:
Double-click the EPSON Scan icon on the desktop.
Or, select the start button icon or Start > All Programs or Programs > EPSON > EPSON Scan > EPSON
Scan.

❏ Mac OS X:
Select Applications > Epson Software > EPSON Scan.

How to access the help

Click the Help button on the Epson Scan driver.
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Starting Other Scanning Software

Note:
Some scanning software may not be included in some countries.

Epson Event Manager

This lets you assign any of the product buttons to open a scanning program. You can also save frequently used
scanning settings, which can really speed up your scanning projects.

How to start
❏ Windows:

Select the start button or Start > All Programs or Programs> Epson Software > Event Manager.

❏ Mac OS X:
Select Applications > Epson Software, and then double-click the Launch Event Manager icon.

How to access the help
❏ Windows:

Click the  icon in the upper right corner of the screen.

❏ Mac OS X:
Click menu > Help > Epson Event Manager Help.

ABBYY FineReader

This software lets you scan a document and convert the text into data that you can edit with a word processing
program.

OCR software cannot recognize, or has difficulty recognizing, the following types of documents or text.

❏ Handwritten characters

❏ Items that have been copied from other copies

❏ Faxes

❏ Text with tightly spaced characters or line pitch

❏ Text that is in tables or underlined

❏ Cursive or italic fonts, and font sizes less than 8 points

❏ Folded or wrinkled documents

See the ABBYY FineReader help for more details.

How to start
❏ Windows:

Select the start button or Start > All Programs or Programs > ABBYY FineReader folder > ABBYY
FineReader.
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❏ Mac OS X:
Select Applications, and then double-click ABBYY FineReader.

Presto! PageManager

This software lets you scan, manage, and share your photos or documents.

How to start
❏ Windows:

Select the start button or Start > All Programs or Programs > Presto! PageManager folder > Presto!
PageManager.

❏ Mac OS X:
Select Application > Presto! PageManager, and then double-click the Presto! PageManager icon.
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Faxing

Introducing FAX Utility

FAX Utility is a software capable of transmitting data such as documents, drawings, and tables created using a word
processing or spreadsheet application directly by fax, without printing. In addition, this utility has a function to save a
received fax as a PDF file on a computer. This enables you to check the data without printing it and print only the data
that you want to print. Use the following procedure to run the utility.

Windows
Click the start button (Windows 7 and Vista) or click Start (Windows XP), point to All Programs, select Epson
Software, and then click FAX Utility.

Mac OS X
Click System Preference, click Print & Fax or Print & Scan, and then select FAX (your printer) from Printer. Then
click as follows;
Mac OS X 10.6.x, 10.7.x: Option & Supplies - Utility - Open Printer Utility
Mac OS X 10.5.x: Open Print Queue - Utility

Note:
For more details, see the online help for FAX Utility.

Connecting to a Phone Line

About a phone cable

Use a phone cable with the following interface specification.

❏ RJ-11 Phone Line

❏ RJ-11 Telephone set connection

Depending on the area, a phone cable may be included with the product. If so, use that cable.
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Using the phone line for fax only

A Connect a phone cable leading from a telephone wall jack to the LINE port.

B Make sure Auto Answer is set to On.
& “Setting up to receive faxes automatically” on page 91

c Important:
If you do not connect an external telephone to the product, make sure you turn on auto answer. Otherwise, you cannot
receive faxes.

Sharing line with phone device

A Connect a phone cable leading from a telephone wall jack to the LINE port.
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B Remove the cap.

C Connect a phone or answering machine to the EXT. port.

Note:
❏ See the following for other connection methods.

❏ For details, see the documentation that came with your devices.
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Connecting to DSL

a Telephone wall jack

b Splitter

c DSL modem

Connecting to ISDN (one phone number)

a ISDN wall jack

d Terminal adapter or ISDN router
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Connecting to ISDN (two phone numbers)

a ISDN wall jack

d Terminal adapter or ISDN router

Checking the fax connection

You can check whether the product is ready to send or receive faxes.

A Load plain paper in the cassette.
& “Loading Paper into the Paper Cassette” on page 24

Note:
If your product is equipped with two cassettes, load paper in cassette 1. If you have changed the Paper Source setting
(Setup > Fax Settings > Receive Settings > Paper Source), load paper in the cassette you specified.

B Enter Setup mode from the Home menu.

C Select Fax Settings.

D Select Check Fax Connection.

E Press one of the x buttons to print the report.

Note:
If an errors are reported, try the solutions in the report.
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Notices when the power is turned off

When the power is left off for an extended period of time, the clock may be reset. Check the clock when you turn the
power back on.

If the product is turned off due to a power failure, it automatically restarts and beeps when the power is restored. If you
have set to receive faxes automatically (Auto Answer - On), the setting is also restored. Depending on the
circumstances before the power failure, it may not restart.

Setting Up Fax Features

Setting up speed dial entries

You can create a speed dial list allowing you to select fax recipient numbers quickly when faxing. Up to 100 combined
speed dial and group dial entries can be registered.

A Enter Fax mode from the Home menu.

B Press  or select Contacts.

C Select Edit Contacts.

D Select Speed Dial Setup. You see the available speed dial entry numbers.

E Select the speed dial entry number that you want to register. You can register up to 100 entries.

F Use the numeric keypad to enter a phone number. You can enter up to 64 digits.

Note:
A hyphen ("-") causes a slight pause when dialing. Only include it in phone numbers when a pause is necessary. Spaces
entered between numbers are ignored when dialing.

G Enter a name to identify the speed dial entry. You can enter up to 30 characters.

H Select Done to register the name.

Setting up group dial entries

You can add speed dial entries to a group, allowing you to send a fax to multiple recipients at the same time. Up to 99
combined speed dial and group dial entries can be entered.

A Enter Fax mode from the Home menu.
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B Press  or select Contacts.

C Select Edit Contacts.

D Select Group Dial Setup. You see the available group dial entry numbers.

E Select the group dial entry number that you want to register.

F Enter a name to identify the group dial entry. You can enter up to 30 characters.

G Select Done to register the name.

H Select a speed dial entry that you want to register in the group dial list.

I Repeat step 8 to add other speed dial entries to the group dial list. You can register up to 99 speed dial entries in a
group dial.

J Press OK to finish creating a group dial list.

Creating header information

You can create a fax header by adding information such as your phone number or name.

Note:
Make sure you have set the time correctly.
& “Setting/Changing Time and Region” on page 122

A Enter Setup mode from the Home menu.

B Select Fax Settings.

C Select Communication.

D Select Header.

E Select Fax Header.

F Enter the header information. You can enter up to 40 characters.
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G Select Done.

H Select Your Phone Number.

I Use the numeric keypad with other buttons on the control panel to enter your phone number. You can enter up
to 20 digits.

Note:
Press the # button to enter a plus sign (+) which represents the international call prefix. Note that the asterisk (*) is
unavailable.

J Press OK or select Done to register the header information.

Changing Fax Output setting to print

You can select whether to save the received fax as a data file or to print it. Follow the instructions below to change the
fax output setting to print.

Note:
❏ Use FAX Utility to change the setting to save the received fax as a data file. You cannot change the setting to save from

the control panel.

❏ When you change the setting from save to print, the received fax data stored in the product’s memory will be printed
automatically.

A Enter Setup mode from the Home menu.

B Select Fax Settings.

C Select Receive Settings.

D Select Fax Output.

E Select Print.

Sending Faxes

Sending faxes by entering a number

A Place your original in the Automatic Document Feeder or on the scanner glass.
& “Placing Originals” on page 32
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B Enter Fax mode from the Home menu.

C Use the keys on the numeric keypad to enter the fax number. You can enter up to 64 digits.

Note:
❏ To display the last fax number you used, press  or Redial.

❏ Press d and make the send settings. To scan and fax both sides of your original, select 2-Sided Faxing, On, and
then load the original in the Automatic Document Feeder. Depending on the model, you can also make the
settings by selecting Send Settings.

❏ Make sure you have entered the header information. Some fax machines automatically reject incoming faxes
that do not include header information.

D Press x (color) or x (B&W) to start sending a color or monochrome fax.

Note:
If the fax number is busy or there is some problem, this product redials after one minute. Press Redial to redial immediately.

Sending faxes using speed dial/group dial

Follow the instructions below to send faxes using speed dial/group dial. When using group dial, you can only send
B&W faxes.

A Place your original in the Automatic Document Feeder or on the scanner glass.
& “Placing Originals” on page 32

B Enter Fax mode from the Home menu.

C Press  or select Contacts.

D Select the entry number to send.

Note:
Press d and make the send settings. Depending on the model, you can also make the settings by selecting Send
Settings.

E Press x (color) or x (B&W) to start sending a color or monochrome fax.

Sending faxes by broadcasting

Broadcast allows you to easily send the same fax to multiple numbers (up to 100) using speed dial/group dial, or by
entering the fax numbers. Follow the instructions below to send faxes by broadcasting.
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Note:
You can only send B&W faxes.

For WF-3540 series

A Place your original in the Automatic Document Feeder or on the scanner glass.
& “Placing Originals” on page 32

B Enter Fax mode from the Home menu.

C Select Advanced Options.

D Select Broadcast Fax.

E Select Add New.

F Select Enter Fax Number.

G Enter a fax number and select Done.

Note:
❏ To add another number, repeat steps 5 through 7.

❏ If you do not need to add recipients from the speed dial/group dial lists, go to step 12.

H Select Add New.

I Select Select from Contacts.

J Select the entry number of the speed dial and the group dial.

K Select Done.

L Select Done.

M Press x(B&W) to start sending.

For WF-3520 series and WF-3530 series

A Place your original in the Automatic Document Feeder or on the scanner glass.
& “Placing Originals” on page 32
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B Enter Fax mode from the Home menu.

C Press d to enter Settings.

D Select Broadcast Fax.

E Enter a fax number.

F Press d then add a fax number.

Note:
❏ To add another number, repeat step 5 and 6.

❏ If you do not need to add recipients from the speed dial/group dial lists, go to step 9.

G Press .

H Select the entry number of the speed dial and the group dial.

I Press OK.

J Press x(B&W) to start sending.

Sending a fax at a specified time

Follow the instructions below to send a fax at a specified time.

Note:
❏ Make sure you have set the time correctly.

& “Setting/Changing Time and Region” on page 122

❏ You can only send B&W faxes.

A Place your original in the Automatic Document Feeder or on the scanner glass.
& “Placing Originals” on page 32

B Enter Fax mode from the Home menu.

C Enter a fax number. You can also use redial, speed dial, or group dial lists to select fax number.

D If Advanced Options is displayed on the LCD screen, select Advanced Options.
If it is not displayed, press d.
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E Select Send Fax Later.

F Select On.

G Set the time that you want to send the fax.

H Press the x (B&W) button to start scanning. The scanned image is sent at the specified time.

Note:
If you need to cancel faxing at the time you specified, press y.

Sending a fax from a connected phone

If the recipient has the same number for both phone and fax, you can send a fax after talking over the phone without
hanging up.

A Place your original in the Automatic Document Feeder or on the scanner glass.
& “Placing Originals” on page 32

B Dial a number from the phone connected to the product.

C Select Send on the control panel of the product.

D Press x (color) or x (B&W) to start sending a color or monochrome fax.

E Hang up the phone.
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Receiving Faxes

Setting up to receive faxes automatically

Follow the instructions to make settings to receive faxes automatically.

Note:
❏ Depending on the Fax Output settings, the received fax is saved as a data or printed.

& “Changing Fax Output setting to print” on page 86

❏ If Fax Output is set to Save, the received fax data is automatically saved as data, and you can skip step 1.

A Load plain paper in the cassette.
& “Loading Paper into the Paper Cassette” on page 24

Note:
If your product is equipped with two cassettes, make Paper Source settings.
Setup > Fax Settings > Receive Settings > Paper Source
If you want to print a large quantity of faxes in a single batch, load plain paper in both cassettes and set Paper Source
to Cassette 1>Cassette 2.

B Make sure Auto Answer is set to On.
Setup > Fax Settings > Receive Settings > Auto Answer > On

Note:
❏ When an answering machine is connected directly to this product, make sure you set Rings to Answer correctly

using the following procedure.

❏ Depending on the region, Rings to Answer may be unavailable.

C Enter Setup mode from the Home menu.

D Select Fax Settings.

E Select Communication.

F Select Rings to Answer.

G Select the number of rings.

c Important:
Select more rings than needed for the answering machine to pick up. If it is set to pick up on the fourth ring, set the
product to pick up on the fifth ring or later. Otherwise the answering machine cannot receive voice calls.
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Note:
When you receive a call and the other party is a fax, the product receives the fax automatically even if the answering machine
picks up the call. If you pick up the phone, wait until the LCD screen displays a message saying that a connection has been
made before you hang up. If the other party is a caller, the phone can be used as normal or a message can be left on the
answering machine.

Receiving faxes manually

If your phone is connected to the product, and Auto Answer mode has been set to Off, you can receive fax data after the
connection is made.

Note:
❏ Depending on the Fax Output settings, the received fax is saved as data or printed.

& “Changing Fax Output setting to print” on page 86

❏ If Fax Output is set to Save, the received fax data is automatically saved as data, and you can skip step 1.

A Load plain paper in the cassette.
& “Loading Paper into the Paper Cassette” on page 24

Note:
If your product is equipped with two cassettes, make Paper Source settings.
Setup > Fax Settings > Receive Settings > Paper Source
If you want to print a large quantity of faxes in a single batch, load plain paper in both cassettes and set Paper Source
to Cassette 1>Cassette 2.

B When the telephone rings, lift the phone connected to the product.

C When you hear a fax tone, select Receive on the control panel of the product.

D Press one of the x buttons to start receiving the fax, and then put the phone back on the hook.

Note:
If Fax Output is set to Save, the received fax data is automatically saved as data, and you do not have to proceed to
step 5.

E Press one of the x buttons to print your faxes.
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Receive a fax by polling

This allows you to receive a fax from the fax information service you have called.

Note:
❏ Depending on the Fax Output settings, the received fax is saved as a data or printed.

& “Changing Fax Output setting to print” on page 86

❏ If Fax Output is set to Save, the received fax data is automatically saved as data, and you can skip step 1.

Follow the instructions below to receive a fax by polling.

A Load plain paper in the cassette.
& “Loading Paper into the Paper Cassette” on page 24

Note:
If your product is equipped with two cassettes, load paper in cassette 1. If you have changed the Paper Source setting
(Setup > Fax Settings > Receive Settings > Paper Source), load paper in the cassette you specified.

B Enter Fax mode from the Home menu.

C If Advanced Options is displayed on the LCD screen, select Advanced Options.
If it is not displayed, press d.

D Select Polling.

E Select On.

F Enter the fax number.

G Press one of the x buttons to receive the fax.

Note:
❏ If Fax Output is set to Save, the received fax data is automatically saved as data, and you do not have to proceed

to step 8.

❏ If Auto Answer mode is turned on, the received fax data is automatically printed, and you do not have to proceed
to step 8.

H Press one of the x buttons to print the received fax.

Printing Reports

Follow the instructions below to print a fax report.
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A Load plain paper in the cassette.
& “Loading Paper into the Paper Cassette” on page 24

Note:
If your product is equipped with two cassettes, make Paper Source settings.
Setup > Fax Settings > Receive Settings > Paper Source

B Enter Fax mode from the Home menu.

C If Advanced Options is displayed on the LCD screen, select Advanced Options.
If it is not displayed, press d.

D Select Fax Report.

E Select the item you want to print.

Note:
Only Fax Log can be viewed on the screen.

F Press one of the x buttons to print the report you selected.

Fax Mode Menu List

Refer to the section below for the Fax mode menu list.
& “Fax Mode” on page 98
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More Functions

More Functions provides you with many special menus that make printing easy and fun! For more details, select More
Functions, select each menu, and then follow the instructions on the LCD screen.

Menu Functions

ID Card Copy You can copy both sides of an ID card at the
same time.

Print Photos You can print photos stored on a memory
card or an external USB device without
using a computer. You can also reduce and
enlarge your photos, and adjust the photo
quality.

Copy/Restore Photos You can make faithful copies of your
originals. If your original photo is faded,
you can restore color to bring it back to life.

Photo Layout Sheet You can print your photos on a memory
card in various layouts.

Print Ruled Papers You can print ruled paper or graph paper
with or without a photo set as the
background.
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You can also print from your digital camera. Remove the memory card, select Setup > External Device Setup > Print
Settings, and then make the appropriate settings. Connect and turn on the camera. For details, see your camera’s guide
to print.

Note:
❏ PictBridge is compatible, and the supported file format is JPEG. For the supported image size, see “Memory card” on

page 173.

❏ Depending on the settings on this printer and the digital camera, some combinations of paper type, size, and layout may
not be supported.

❏ Some of the settings on your digital camera may not be reflected in the output.
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Menu List of Control Panel

You can use this product as a printer, copier, scanner, and fax. When using one of these functions, except the printer
function, select your desired function by pressing the corresponding Mode button on the control panel. Each mode’s
main screen appears as you select the mode.

Note:
Although what displayed on the LCD screen such as menu names and option names may differ from your actual product, the
method of operation is the same.

Copy Mode

Note:
Depending on the model, some functions may not be available.

Paper and Copy Settings

Menu Setting and Options

2-Sided Copying 1>1-Sided, 2>2-Sided, 1>2-Sided, 2>1-Sided

Collate Copy Off, On

Layout With Border, Borderless*, A4, 2-up Copy

Reduce/Enlarge Custom Size, Actual Size, Auto Fit Page, 10x15cm->A4, A4->10x15cm, 13x18->10x15,
10x15->13x18, A5->A4, A4->A5

Paper Size A4, A5, 10x15cm(4x6in), 13x18cm(5x7in), Legal

Paper Type Plain Paper, Matte, Prem. Glossy, Ultra Glossy, Glossy, Photo Paper

Paper Source Cassette 1, Cassette 2, Cassette 1>Cassette 2

Quality Draft, Standard Quality, Best

Document Orientation Portrait, Landscape

Binding Direction Left, Top

Binding Margin Left, Top

Expansion Standard, Medium, Minimum

Dry Time Standard, Long, Longer

*Your image is slightly enlarged and cropped to fill the sheet of paper. Print quality may decline in the top and bottom areas of the
printout, or the area may be smeared when printing.
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Fax Mode

Note:
Depending on the model, some functions may not be available.

Menu Setting item Description

Send Settings Resolution Select this option to change the resolution for fax data
you are sending.

Contrast Select this option to change the contrast for fax data
you are sending.

2-Sided Faxing Turn on when sending 2-sided originals in the ADF.

Send Fax Later - & See “Sending a fax at a specified time” on
page 89

Broadcast Fax - & See “Sending faxes by broadcasting” on page 87

Polling - & See “Receive a fax by polling” on page 93

Fax Report Fax Log Prints or displays the communication log.

Last Transmission Prints a communication-in log for the previous
transmission or the previous polling results received.

Contact List Prints the Contacts list.

Speed Dial List Prints the speed dial list.

Group Dial List Prints the group dial list.

Reprint Faxes Reprints from the latest fax received. When the
memory is full, the oldest faxes are erased first.

Protocol Trace Prints the protocol for the latest communication.

     User’s Guide

Menu List of Control Panel

98



Scan Mode

Menu Setting and Options

Scan to Memory Card Format JPEG, PDF

2-Sided Scanning Off, On

Scan Area A4, Auto Cropping, Max Area, Legal

Document Text, Photograph

Resolution 200dpi, 300dpi, 600dpi

Contrast -4 to +4

Document Orientation Portrait, Landscape

Binding Direction Left, Top

Scan to Cloud *1

Scan to PC 2-Sided Scanning Off, On

Scan to PC (PDF)

Scan to PC (Email)

Scan to PC (WSD)*2

*1 For instructions on using Scan to Cloud, see the Epson Connect guide.;
& “Using Epson Connect Service” on page 9

*2 Available for computers running English versions of Windows 7 or Vista.

More Functions Mode Menu List

Note:
Depending on the model, some functions may not be available.

Menu Setting and Options

ID Card Copy Paper Size A4

Paper Source Cassette 1, Cassette 2, Cassette 1>Cassette 2
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Menu Setting and Options

Print Photos* Select Photos Select All Photos, Select by Date, Cancel Photo
Selection

Select Location Select Folder, Select Group

Display Mode 1-up, 1-up without Information, 9-up

Print Settings Paper Size, Paper Type, Borderless, Quality,
Expansion, Date, Fit Frame, Bidirectional, Paper
Source

Photo Adjustments Enhance, Scene Detection, Fix Red-Eye, Filter,
Brightness, Contrast, Sharpness, Saturation

Crop/Zoom

Copy/Restore Photos Color Restoration Off, On

Display Mode 1-up, 1-up without Information, 9-up

Paper and Copy Settings Paper Size, Paper Type, Paper Source, Borderless,
Expansion

Photo Adjustments Enhance, Filter

Crop/Zoom

Photo Layout Sheet* 2-up, 4-up, 8-up, 20-up, Upper 1/2, Lower 1/2, Photo ID

Paper Size 10x15cm(4x6in), 13x18cm(5x7in), A4

Paper Type Prem. Glossy, Ultra Glossy, Glossy, Photo Paper, Plain
Paper, Matte

Layout Method Automatic layout, Place photos manually

Menu Select Photos, Display Mode, Print Settings, Photo
Adjustments, Crop/Zoom

Print Ruled Papers Wide Rule Only, Thin Rule Only, Graph Paper Only, Watermark without Rule, Watermark Horizontal
Rule, Watermark Vertical Rule

* The menu hierarchy varies depending on the product.

Eco Mode Menu List

Menu Setting and Options

Sleep Timer 3minutes, 5minutes, 10minutes

2-Sided Printing Off, On

Preview -
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Wi-Fi Setup Mode Menu List

Note:
Depending on the model, some functions may not be available.

Menu Setting and Options

Wi-Fi Auto Connect For details on the setting items, see the online Network Guide.

Wi-Fi Setup Wizard

Push Button Setup (WPS)

PIN Code Setup (WPS)

Wi-Fi Direct Connection
Setup

Wi-Fi/Network Status

Disable Wi-Fi

Setup Mode

Note:
Depending on the model, some functions may not be available.

Menu Setting Item Description

Ink Levels - Checks the status of ink cartridges and maintenance
box.

Maintenance Nozzle Check Prints a nozzle check pattern to check the condition of
the print head.

Head Cleaning Cleans the print head to improve the condition of the
print head.

Print Head Alignment Adjusts the alignment of the print head.

Ink Cartridge Replacement Replaces the ink cartridges.
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Menu Setting Item Description

Printer Setup Sound Button Press, Error Notification, Completion Notice,
Volume

Screen Saver Off, Memory Card Data

Date/Time & See “Setting/Changing Time and Region” on
page 122

Daylight Saving Time -

Country/Region & See “Setting/Changing Time and Region” on
page 122

Language -

Wi-Fi/Network Settings Wi-Fi Setup See the online Network Guide. You can access the
Wi-Fi Setup menus directly by selecting Wi-Fi Setup
from the Home menu.Manual Wi-Fi/Network Setup

Wi-Fi/Network Connection Check You can check the network connection status, and
print the report. If there is any problem with the
connection, the report helps you find the solution.

Wi-Fi/Network Status You can see the current network settings and print a
network status sheet.

Epson Connect Services For instructions on use, see the Epson Connect guide.
& “Using Epson Connect Service” on page 9

Google Cloud Print
Services

File Sharing Setup For details on the setting items, see the online Network Guide.

Fax Settings Send Settings Resolution: Select this option to change the
resolution for fax data you are sending.

Contrast: Select this option to change the contrast for
fax data you are sending.

2-Sided Faxing: Turn on when sending 2-sided
originals in the ADF.

Last Transmission Report: Indicates whether or
when the product prints a report for outgoing faxes.
Select Off to turn off report printing, select On Error
to print reports only when an error occurs, or select
On Send to print reports for every fax you send.

Receive Settings Auto Answer: & See “Setting up to receive faxes
automatically” on page 91

Paper Size: You can select the paper size you want to
use for printing.

Paper Source: You can select from which cassettes(s)
to feed paper.

Auto Reduction: Indicates whether large received
faxes are reduced in size to fit on A4-size, or printed at
their original size on multiple sheets.

Fax Output: & See “Changing Fax Output setting to
print” on page 86
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Menu Setting Item Description

Communication DRD: Indicates the type of answer ring pattern you
want to use to receive faxes. To select an option other
than All (or Off), you must set up your phone system
to use different ring patterns. This option may be On
or Off depending on the region.

ECM: Indicates whether or not to use Error Correction
Mode to automatically correct fax data sent/received
with errors due to the line or any other problems.
Color faxes cannot be sent/received when ECM is off.

Fax Speed: Indicates the speed at which you transmit
and receive faxes.

Rings to Answer: Indicates the number of rings that
must occur before the product automatically receives
a fax. Depending on the region, this setting may not
be displayed.

Dial Tone Detection: When this is set to On, the
product starts dialing after it detects a dial tone. It may
not be able to detect a dial tone when a PBX (Private
Branch Exchange) or a TA (Terminal Adapter) is
connected. In that case, set to Off. However, doing so
may drop the first digit of a fax number and send the
fax to the wrong number.

Dial Mode: Indicates the type of phone system to
which you have connected the product. Depending
on the region, this setting may not be displayed.

Header: & See “Creating header information” on
page 85

Security Settings Backup Data Auto Erase: Select On if you do not
want to store sent or printed faxes in the product’s
memory. Select Off to store sent or printed faxes until
the memory is full.

Erase Backup Data: Erases sent or printed fax data
from the product’s memory.

Check Fax Connection Checks the status of your fax connection.

External Device Setup Print Settings For details on the setting items, refer to the Print
Photos menu list in the More Functions mode.

Photo Adjustments

Print Status Sheet - -

Restore Default Settings Fax Send/Receive Settings Initializes Fax Send/Receive settings to the factory
default settings.

Fax Data Settings Initializes Fax Data settings to the factory default
settings.

Wi-Fi/Network Settings Initializes Wi-Fi/Network settings to the factory
default settings.

All except Wi-Fi/Network & Fax Settings Initializes all settings except for Wi-Fi/Network & Fax
settings to the factory default settings.

All Settings Initializes all settings to the factory default settings.
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Help Menu List

Menu Options

How to… Navigate Using the Touch Screen

Load Paper in the Rear Paper Feed Slot

Load Paper in the Paper Cassette

Load an Envelope in the Rear Paper Feed Slot

Load Envelopes in the Paper Cassette

Place a Document in the ADF

Place a Document on the Scanner Glass

Insert/Remove a Memory Card/USB Flash Drive

Ink Cartridges Check Ink Cartridge Status

Replace Ink Cartridges

Troubleshooting Cannot Connect to a Wi-Fi

Paper Feeding Incorrectly

Poor Print Quality

Cannot Send or Receive Fax

Cannot Scan to PC

Icon List -
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Replacing Ink Cartridges

Ink Cartridge Safety Instructions, Precautions, and
Specifications

Safety instructions

Observe the following when handling the ink cartridges:

❏ Keep ink cartridges out of the reach of children.

❏ Be careful when you handle used ink cartridges, as there may be some ink around the ink supply port.
If ink gets on your skin, wash the area thoroughly with soap and water.
If ink gets into your eyes, flush them immediately with water. If discomfort or vision problems continue after a
thorough flushing, see a doctor immediately.
If ink gets into your mouth, spit it out immediately and see a doctor right away.

❏ Do not remove or tear the label on the cartridge; this can cause leakage.

❏ Do not remove the transparent seal from the bottom of the cartridge; otherwise, the cartridge may become
unusable.

❏ Do not disassemble or remodel the ink cartridge, otherwise you may not be able to print normally.
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❏ Do not touch the green IC chip on the side of the cartridge. Doing so may prevent normal operation and printing.

❏ Do not leave the product with the ink cartridges removed or do not turn off the product during cartridge
replacement. Otherwise, ink remaining in the print head nozzles will dry out and you may not be able to print.

Precautions on ink cartridge replacement

Read all of the instructions in this section before replacing the ink cartridges.

❏ Epson recommends the use of genuine Epson ink cartridges. Epson cannot guarantee the quality or reliability of
non-genuine ink. The use of non-genuine ink may cause damage that is not covered by Epson’s warranties, and
under certain circumstances, may cause erratic product behavior. Information about non-genuine ink levels may
not be displayed.

❏ Gently shake all ink cartridges four or five times before opening the package.

❏ Do not shake ink cartridges too vigorously; otherwise ink may leak from the cartridge.

❏ This product uses ink cartridges equipped with an IC chip that monitors information such as the amount of
remaining ink for each cartridge. This means that even if the cartridge is removed from the product before it is
expended, you can still use the cartridge after reinserting it back into the product. However, when reinserting a
cartridge, some ink may be consumed to guarantee product performance.

❏ To maintain optimum print head performance, some ink is consumed from some cartridges not only during
printing but also during maintenance operations such as ink cartridge replacement and print head cleaning.

❏ If you need to remove an ink cartridge temporarily, be sure to protect the ink supply area from dirt and dust. Store
the ink cartridge in the same environment as the product. When storing the cartridge, be sure that its label
identifying the color of the ink cartridge is facing upward. Do not store ink cartridges upside down.

❏ The ink supply port is equipped with a valve designed to contain the release of excess ink; there is no need to supply
your own covers or plugs. However, careful handling is recommended. Do not touch the supply port of the ink
cartridge or its surrounding area.

❏ For maximum ink efficiency, only remove an ink cartridge when you are ready to replace it. Ink cartridges with
low ink status may not be used when reinserted.

❏ Do not open the ink cartridge package until you are ready to install it in the product. The cartridge is vacuum
packed to maintain its reliability. If you leave a cartridge unpacked for a long time before using it, normal printing
may not be possible.

❏ Install all ink cartridges; otherwise, you cannot print.
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❏ When color ink is expended and black ink still remains, you can continue printing temporarily with black ink
only. For more information refer to “Temporarily Printing with Black Ink When Color Ink Cartridges are
Expended” on page 110.

❏ If an ink cartridge is running low, prepare a new ink cartridge.

❏ Be careful not to break the hooks on the side of the ink cartridge when you remove it from the package.

❏ You must remove the yellow tape from the cartridge before installing it; otherwise, print quality may decline or
you may not be able to print.

❏ After bringing an ink cartridge inside from a cold storage site, allow it to warm up at room temperature for at least
three hours before using it.

❏ Store ink cartridges in a cool, dark place.

❏ Store ink cartridges with their labels facing upward. Do not store cartridges upside down.

Ink Cartridge Specifications

❏ Epson recommends using the ink cartridge before the date printed on the package.

❏ The ink cartridges packaged with your product are partly used during initial setup. In order to produce high
quality printouts, the print head in your product will be fully charged with ink. This one-off process consumes a
quantity of ink and therefore these cartridges may print fewer pages compared to subsequent ink cartridges.

❏ Quoted yields may vary depending on the images that you are printing, the paper type that you are using, the
frequency of your prints and environmental conditions such as temperature.

❏ To ensure you receive premium print quality and to help protect your print head, a variable ink safety reserve
remains in the cartridge when your product indicates to replace the cartridge. The yields quoted for you do not
include this reserve.

❏ Although the ink cartridges may contain recycled materials, this does not affect product function or performance.

❏ When printing in monochrome or grayscale, color inks instead of black ink may be used depending on the paper
type or print quality settings. This is because a mixture of color inks is used to create black.

Checking the Ink Cartridge Status

For Windows

Note:
When an ink cartridge is running low, the Low Ink Reminder screen automatically appears. You can also check the ink
cartridge status from this screen. If you do not want to display this screen, first access the printer driver and then click the
Maintenance tab, and then Monitoring Preferences. On the Monitoring Preferences screen, clear the See Low Ink
Reminder alerts check box.

To check the ink cartridge status, do one of the following:
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❏ Open the printer driver, click the Main tab, and then click the Ink Levels button.

❏ Double-click the product shortcut icon on your Windows taskbar. To add a shortcut icon to the taskbar, see the
following section:
& “From the shortcut icon on the taskbar” on page 43

❏ Open the printer driver, click the Maintenance tab, then click the EPSON Status Monitor 3 button. A graphic
displays the ink cartridge status.

Note:
❏  If EPSON Status Monitor 3 does not appear, access the printer driver and click the Maintenance tab and then the

Extended Settings button. In the Extended Settings window, check the Enable EPSON Status Monitor 3 check box.

❏ Depending on current settings, the simplified status monitor may be displayed. Click the Details button to display the
window above.

❏ The ink levels displayed are an approximate indication.

For Mac OS X

You can check the ink cartridge status using EPSON Status Monitor. Follow the steps below.

A Access the Epson Printer Utility 4.
& “Accessing the printer driver for Mac OS X” on page 43
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B Click the EPSON Status Monitor icon. The EPSON Status Monitor appears.

Note:
❏ The graphic displays the ink cartridge status when EPSON Status Monitor was first opened. To update the ink cartridge

status, click Update.

❏ The ink levels displayed are an approximate indication.

Using the control panel

A Enter Setup mode from the Home menu.

B Select Ink Levels.

Note:
The ink levels displayed are an approximate indication.
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Temporarily Printing with Black Ink When Color Ink
Cartridges are Expended

When color ink is expended and black ink still remains, you can continue printing for a short time using only black ink.
However, you should replace the expended ink cartridge(s) as soon as possible. See the following section to continue
printing temporarily with black ink.

Note:
The actual amount of time will vary depending on the usage conditions, images printed, print settings, and frequency of
use.

For Windows

Note for Windows:
This function is available only when EPSON Status Monitor 3 is enabled. To enable the status monitor, access the printer
driver and click the Maintenance tab followed by the Extended Settings button. In the Extended Settings window, check the
Enable EPSON Status Monitor 3 check box.

Follow the steps below to continue printing temporarily with black ink.
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A When EPSON Status Monitor 3 tells you to cancel your print job, click Cancel or Cancel Print to cancel your
print job.

Note:
If the error stating that a color ink cartridge is expended originates with another computer on the network, you may
need to cancel the print job at the product.

B Load plain paper or envelope.

C Access the printer settings.
& “Accessing the printer driver for Windows” on page 42

D Click the Main tab, and make suitable settings.

E Select plain papers or Envelope as the Paper Type setting.

F Select the Grayscale as the Color setting.

G Click OK to close the printer settings window.
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H Print your file.

I EPSON Status Monitor 3 is displayed on your computer screen again. Click Print in Black to print with black
ink.

For Mac OS X

Follow the steps below to continue printing temporarily with black ink.

A If printing can not be resumed, click the product icon in the Dock. If an error message is displayed prompting
you to cancel the print job, click Delete and follow the steps below to reprint the document with black ink.

Note:
If the error stating that a color ink cartridge is expended originates with another computer on the network, you may
need to cancel the print job at the product.

B Open System Preferences, click Print & Scan (Mac OS X 10.7) or Print & Fax (Mac OS X 10.6 or 10.5), and
select the product from the Printers list. Next, click Options & Supplies and then Driver.

C Select On for Permit temporary black printing.

D Load plain paper or envelope.

E Access the Print dialog box.
& “Accessing the printer driver for Mac OS X” on page 43

F Click the Show Details button (for Mac OS X 10.7) or the d button (for Mac OS X 10.6 or 10.5) to extend this
dialog box.

G Select the product you are using as the Printer setting, and then make suitable settings.
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H Select Print Settings from the pop-up menu.

I Select plain papers or Envelope as the Media Type setting.

J Select the Grayscale check box.

K Click Print to close the Print dialog box.

Conserving Black Ink When the Cartridge Is Low (For
Windows Only)

Note for Windows:
This function is available only when EPSON Status Monitor 3 is enabled. To enable the status monitor, access the printer
driver and click the Maintenance tab followed by the Extended Settings button. In the Extended Settings window, check the
Enable EPSON Status Monitor 3 check box.

The window below appears when black ink runs low and there is more color ink than black ink. It appears only when
plain papers is selected as the paper type, and Standard is selected as the Quality.

The window gives you the option to either continue using black ink normally or conserve black ink by using a mixture
of color inks to create black.

❏ Click the Yes button to use a mixture of color inks to create black. You will see the same window the next time you
print a similar job.

❏ Click the No button to continue using the remaining black ink for the job you are printing. You will see the same
window the next time you print a similar job, and again have the option to conserve black ink.

❏ Click Disable this feature to continue using the remaining black ink.
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Replacing an ink cartridge

A Open the scanner unit. The ink cartridge holder moves to the ink cartridge replacement position.

c Important:
❏ Do not move the ink cartridge holder by hand; otherwise, you may damage the product.

❏ Do not lift up the scanner unit when the document cover is open.

Note:
If the ink cartridge holder does not move to the ink cartridge replacement position, follow the instruction below.
Home > Setup > Maintenance > Ink Cartridge Replacement

B Open the ink cartridge cover.
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C Pinch and remove the ink cartridge.

Note:
❏ The illustration shows replacement of the black ink cartridge. Replace the cartridge appropriate to your

situation.

❏ Removed ink cartridges may have ink around the ink supply port, so be careful not to get any ink on the
surrounding area when removing the cartridges.

D Gently shake new replacement cartridges four or five times and remove the replacement ink cartridge from its
package.

E Remove only the yellow tape.

     User’s Guide

Replacing Ink Cartridges

115



c Important:
❏ You must remove the yellow tape from the cartridge before installing it; otherwise, print quality may

decline or you may not be able to print.

❏ If you have installed an ink cartridge without removing the yellow tape, take the cartridge out of the
product, remove the yellow tape, and then reinstall it.

❏ Do not remove the transparent seal from the bottom of the cartridge; otherwise, the cartridge may become
unusable.

❏ Do not remove or tear the label on the cartridge; otherwise, ink will leak.

F Insert the cartridge and press it until it clicks.

G Close the ink cartridge cover.

H Close the scanner unit slowly. Ink charging starts.

Note:
❏ The power light continues to flash while the product is charging ink. Do not turn off the product during ink

charging. If the ink charging is incomplete, you may not be able to print.

❏ If you had to replace an ink cartridge during copying, to ensure copy quality after ink charging is finished, cancel
the job that is copying and start again from placing the originals.

Ink cartridge replacement is complete. The product will return to its previous status.
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Maintaining Your Product and Software

Checking the Print Head Nozzles

If you find that the printout is unexpectedly faint or that dots are missing, you may be able to identify the problem by
checking the print head nozzles.

You can check the print head nozzles from your computer by using the Nozzle Check utility or from the product by
using the buttons.

Using the Nozzle Check utility for Windows

Follow the steps below to use the Nozzle Check utility.

A Make sure that no warnings or errors are indicated in the control panel.

B Make sure that A4-size paper is loaded in the paper cassette.

Note:
If the product is equipped with two cassettes, load paper in cassette 1.

C Right-click the product icon on the taskbar, then select Nozzle Check.

If the product icon does not appear, refer to the following section to add the icon.
& “From the shortcut icon on the taskbar” on page 43

D Follow the on-screen instructions.

Using the Nozzle Check utility for Mac OS X

Follow the steps below to use the Nozzle Check utility.

A Make sure that no warnings or errors are indicated in the control panel.

B Make sure that A4-size paper is loaded in the paper cassette.

Note:
If the product is equipped with two cassettes, load paper in cassette 1.

C Access the Epson Printer Utility 4.
& “Accessing the printer driver for Mac OS X” on page 43
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D Click the Nozzle Check icon.

E Follow the on-screen instructions.

Using the control panel

Follow the steps below to check the print head nozzles using the product control panel.

A Make sure that no warnings or errors are indicated in the control panel.

B Make sure that A4-size paper is loaded in the paper cassette.

Note:
If the product is equipped with two cassettes, load paper in cassette 1.

C Enter Setup mode from the Home menu.

D Select Maintenance.

E Select Nozzle Check.

F Press one of the x buttons to print the nozzle check pattern.

Below are two sample nozzle check patterns.

Compare the quality of the printed check page with the sample shown below. If there are no print quality
problems, such as gaps or missing segments in the test lines, the print head is fine.

If any segment of the printed lines is missing, as shown below, this could mean a clogged ink nozzle or a
misaligned print head.

& “Cleaning the Print Head” on page 119 
& “Aligning the Print Head” on page 120
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Cleaning the Print Head

If you find that the printout is unexpectedly faint or that dots are missing, you may be able to solve these problems by
cleaning the print head, which ensures that the nozzles are delivering ink properly.

You can clean the print head from your computer using the Head Cleaning utility in the printer driver or from the
product by using the buttons.

c Important:
Do not turn off the product during head cleaning. If the head cleaning is incomplete, you may not be able to print.

Note:
❏ Do not open the scanner unit during head cleaning.

❏ Perform the nozzle check first to identify any defective color(s); this will allow you to select the appropriate color(s) for
the head cleaning function.
& “Checking the Print Head Nozzles” on page 117

❏ Black ink may be used when printing color images.

❏ Because print head cleaning uses some ink from some cartridges, clean the print head only if quality declines; for
example, if the printout is blurry or the color is incorrect or missing.

❏ When ink is low you may not be able to clean the print head. When ink is expended you cannot clean the print head.
Replace the appropriate ink cartridge first.

❏ If print quality does not improve, make sure you selected the appropriate color according to the nozzle check result.

❏ If print quality has not improved after repeating this procedure about four times, leave the product on and wait for at
least six hours. Then run the nozzle check again and repeat the head cleaning if necessary. If print quality has still not
improved, contact Epson support.

❏ To maintain print quality, we recommend printing a few pages on a regular basis.

Using the Head Cleaning utility for Windows

Follow the steps below to clean the print head using the Head Cleaning utility.

A Make sure that no warnings or errors are indicated in the control panel.

B Right-click the product icon on the taskbar, then select Head Cleaning.

If the product icon does not appear, refer to the following section to add the icon.
& “From the shortcut icon on the taskbar” on page 43

C Follow the on-screen instructions.

Using the Head Cleaning utility for Mac OS X

Follow the steps below to clean the print head using the Head Cleaning utility.
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A Make sure that no warnings or errors are indicated in the control panel.

B Access the Epson Printer Utility 4.
& “Accessing the printer driver for Mac OS X” on page 43

C Click the Head Cleaning icon.

D Follow the on-screen instructions.

Using the control panel

Follow the steps below to clean the print head using the product control panel.

A Make sure that no warnings or errors are indicated in the control panel.

B Enter Setup mode from the Home menu.

C Select Maintenance.

D Select Head Cleaning.

E Follow the instructions on the LCD screen to continue.

F Select the color you want to clean, and follow the instructions on the LCD screen to start cleaning.

Note:
Select the color that shows a defect in the nozzle check result.

Aligning the Print Head

If you notice a misalignment of vertical lines or horizontal banding, you may be able to solve this problem by using the
Print Head Alignment utility in your printer driver or by using the product buttons.

Refer to the appropriate section below.

Note:
Do not press y to cancel printing while printing a test pattern with the Print Head Alignment utility.

Using the Print Head Alignment utility for Windows

Follow the steps below to align the print head using the Print Head Alignment utility.
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A Make sure that no warnings or errors are indicated in the control panel.

B Make sure A4-size paper is loaded in the paper cassette.

Note:
If the product is equipped with two cassettes, load paper in cassette 1.

C Right-click the product icon on the taskbar, then select Print Head Alignment.

If the product icon does not appear, refer to the following section to add the icon.
& “From the shortcut icon on the taskbar” on page 43

D Follow the on-screen instructions to align the print head.

Using the Print Head Alignment utility for Mac OS X

Follow the steps below to align the print head using the Print Head Alignment utility.

A Make sure that no warnings or errors are indicated in the control panel.

B Make sure A4-size paper is loaded in the paper cassette.

Note:
If the product is equipped with two cassettes, load paper in cassette 1.

C Access the Epson Printer Utility 4.
& “Accessing the printer driver for Mac OS X” on page 43

D Click the Print Head Alignment icon.

E Follow the on-screen instructions to align the print head.

Using the control panel

Follow the steps below to align the print head using the product control panel.

A Make sure that no warnings or errors are indicated in the control panel.

B Make sure that A4-size paper is loaded in the paper cassette.

Note:
If the product is equipped with two cassettes, load paper in cassette 1.
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C Enter Setup mode from the Home menu.

D Select Maintenance.

E Select Print Head Alignment.

F Press one of the x buttons to print the patterns.

G Find the most solid pattern in each of #1 to #5 groups.

H Enter the pattern number for the most solid pattern in #1 group.

I Repeat step 8 for the other groups (#2 to #5).

J Finish aligning the print head.

Setting/Changing Time and Region

Follow the steps below to set the time and region using the product control panel.

A Enter Setup mode from the Home menu.

B Select Printer Setup.

C Select Date/Time.

D Select the date format.

E Set the date.

F Select the time format.
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G Set the time.

Note:
To select daylight saving time, set Daylight Saving Time to On.

H Select Country/Region.

I Select the region.

J Select Yes.

Note:
When the power is left off for an extended period of time, the clock may be reset. Check the clock when you turn the power
back on.

Saving Power

The LCD screen turns black if no operations are performed for a set period.

You can adjust the time before power management is applied. Any increase will affect the product’s energy efficiency.
Please consider the environment before making any change.

Follow the steps below to adjust the time.

For Windows

A Access the printer settings.
& “Accessing the printer driver for Windows” on page 42

B Click the Maintenance tab, and then click the Printer and Option Information button.

C Select 3 minutes, 5 minutes, or 10 minutes as the Sleep Timer setting.

D Click the OK button.

For Mac OS X

A Access the Epson Printer Utility 4.
& “Accessing the printer driver for Mac OS X” on page 43

B Click the Printer Settings button. The Printer Settings screen appears.
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C Select 3 minutes, 5 minutes, or 10 minutes as the Sleep Timer setting.

D Click the Apply button.

Using the control panel

A Enter Eco Mode mode from the Home menu.

B Select Sleep Timer.

C Select 3minutes, 5minutes, or 10minutes.

Cleaning the Product

Cleaning the exterior of the product

To keep your product operating at its best, clean it thoroughly several times a year by using the following instructions.

c Important:
Never use alcohol or thinner to clean the product. These chemicals can damage the product.

Note:
Close the rear paper feed slot after you use the product to protect the product from dust.

❏ Use a soft, dry, clean cloth to clean the touch panel/touchpad. Do not use liquid or chemical cleaners.

❏ Use a soft, dry, clean cloth to clean the surface of the scanner glass.
If straight lines appear in the printout or the scanned data, clean the small scanner glass on the left carefully.

❏ If the glass surface is stained with grease or some other hard-to-remove material, use a small amount of glass
cleaner and a soft cloth to remove it. Wipe off all remaining liquid.
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❏ Open the ADF cover and use a soft, dry, clean cloth to clean the roller and the interior of the ADF.

❏ Do not press the surface of the scanner glass with any force.

❏ Be careful not to scratch or damage the surface of the scanner glass, and do not use a hard or abrasive brush to clean
it. A damaged glass surface can decrease the scan quality.

Cleaning the interior of the product

To keep your print results at their best, clean the roller inside by using the following procedure.

!Caution:
Be careful not to touch the parts inside the product.

c Important:
❏ Be careful to keep water away from the electronic components.

❏ Do not spray the inside of the product with lubricants.

❏ Unsuitable oils can damage the mechanism. Contact your dealer or a qualified service person if lubrication is
needed.

A Make sure that no warnings or errors are indicated in the control panel.

B Load several sheets of A4-size plain paper in the paper cassette.

Note:
If the product is equipped with two cassettes, load paper in cassette 1.

C Enter Copy mode from the Home menu.

D Press one of the x buttons to make a copy without placing a document on the scanner glass.

E Repeat step 4 until the paper is not smeared with ink.
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Replacing Maintenance Box

Checking the maintenance box status

The maintenance box status is shown in the same screen of the ink cartridge status. You can check the status from the
printer software or the control panel.
& “Checking the Ink Cartridge Status” on page 107

Handling precautions

Read all of the instructions in this section before replacing the maintenance box.

❏ Epson recommends the use of a genuine Epson maintenance box. The use of a non-genuine maintenance box may
cause damage that is not covered by Epson’s warranties, and under certain circumstances, may cause erratic
printer behavior. Epson cannot guarantee the quality or reliability of a non-genuine maintenance box.

❏ Do not dismantle the maintenance box.

❏ Do not touch the green IC chip on the side of the maintenance box.

❏ Keep out of reach of children, and do not drink the ink.

❏ Do not tilt the used maintenance box until it is placed in the plastic bag provided.

❏ Do not reuse a maintenance box which has been removed and left detached for a long period.

❏ Keep the maintenance box away from direct sunlight.

Replacing a maintenance box

To replace the maintenance box, follow the steps below.

A Press the P button to turn off the product.

B Confirm that the product is not draining the ink.

C Remove the replacement maintenance box from the package.

Note:
Do not touch the green chip on the side of the box. Doing so may prevent normal operation.
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D Pull out the rear cover.

E Put your hand on the handle of the maintenance box, and then pull the box outward.

Note:
If ink gets on your hands, wash them thoroughly with soap and water. If ink gets into your eyes, flush them
immediately with water.

F Put the used maintenance box in the plastic bag provided with the replacement box, and dispose of it properly.

Note:
Do not tilt the used maintenance box until after it is sealed in the plastic bag.

G Insert the maintenance box into place as far as it will go.
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H Reattach the rear cover.

I Press the P button to turn the product back on.

Maintenance box replacement is complete.

Transporting the Product

If you move the product some distance, you need to prepare it for transportation in its original box or one of a similar
size.

c Important:
❏ When storing or transporting the product, avoid tilting it, placing it vertically, or turning it upside down;

otherwise ink may leak.

❏ Leave the ink cartridges installed. Removing the cartridges can dry out the print head and may prevent the product
from printing.

A Plug in the product and turn it on. Wait until the ink cartridge holder returns to the home position, then close
the scanner unit slowly.

B Turn off the product and unplug its power cord.

C Disconnect all other cables from the product.
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D Remove all paper from the rear paper feed slot.

E Close the rear paper feed slot and the output tray.

F Remove all paper from the paper cassette and re-insert the cassette into the product.

G Repack the product in its box, using the protective materials that came with it.

Note:
Keep the product level during transport.

Checking and Installing Your Software

Checking the software installed on your computer

To use the functions described in this User’s Guide, you need to install the following software.

❏ Epson Driver and Utilities

❏ Epson Easy Photo Print

❏ Epson Event Manager

Follow the steps below to check that the software is installed on your computer.

For Windows

A Windows 7 and Vista: Click the start button and select Control Panel.

Windows XP: Click Start and select Control Panel.

B Windows 7 and Vista: Click Uninstall a program from the Programs category.

Windows XP: Double-click the Add or Remove Programs icon.

C Check the list of currently installed programs.

For Mac OS X

A Double-click Macintosh HD.

B Double-click the Epson Software folder in the Applications folder and check the contents.
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Note:
❏ The Applications folder contains software provided by third parties.

❏ To check that the printer driver is installed, click System Preferences on the Apple menu and then click Print & Scan
(for Mac OS X 10.7) or Print & Fax (for Mac OS X 10.6 or 10.5). Then locate your product in the Printers list box.

Installing the software

Insert the product software disk that came with your product and select the software you want to install on the Software
Select screen.

Uninstalling Your Software

You may need to uninstall and then reinstall your software to solve certain problems or if you upgrade your operating
system.

See the following section for information on determining what applications are installed.
& “Checking the software installed on your computer” on page 129

For Windows

Note:
❏ For Windows 7 and Vista, you need an administrator account and password if you log on as a standard user.

❏ For Windows XP, you must log on to a Computer Administrator account.

A Turn off the product.

B Disconnect the product’s interface cable from your computer.

C Do one of the following.

Windows 7 and Vista: Click the start button and select Control Panel.

Windows XP: Click Start and select Control Panel.

D Do one of the following.

Windows 7 and Vista: Click Uninstall a program from the Programs category.

Windows XP: Double-click the Add or Remove Programs icon.

E Select the software you want to uninstall such as your product’s driver and the application from the list
displayed.
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F Do one of the following.

Windows 7: Click Uninstall/Change or Uninstall.

Windows Vista: Click Uninstall/Change or Uninstall, and then click Continue in the User Account Control
window.

Windows XP: Click Change/Remove or Remove.

Note:
If you chose to uninstall your product’s printer driver in step 5, select the icon for your product and then click
OK.

G When the confirmation window appears, click Yes or Next.

H Follow the on-screen instructions.

In some cases, a message may appear to prompt you to restart your computer. If so, make sure I want to restart my
computer now is selected and click Finish.

For Mac OS X

Note:
❏ To uninstall your software you need to download the Uninstaller.

Access the site at:
http://www.epson.com
Next, select the support section of your local Epson Web site.

❏ To uninstall applications, you must log on to a Computer Administrator account.
You cannot uninstall programs if you log on as a limited account user.

❏ Depending on the application, the Installer may be separated from the Uninstaller.

A Quit all running applications.

B Double-click the Uninstaller icon in your Mac OS X hard drive.

C Select the check boxes for the software you want to uninstall, such as the printer driver and the application, from
the list displayed.

D Click Uninstall.

E Follow the on-screen instructions.

If you cannot find the software you want to uninstall in the Uninstaller window, double-click the Applications folder
in your Mac OS X hard drive, select the application you want to uninstall, and then drag it to the Trash icon.
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Note:
If you uninstall the printer driver and the name of your product remains in the Print & Scan (for Mac OS X 10.7) or Print &
Fax (for Mac OS X 10.6 or 10.5) window, select the name of your product and click the - remove button.
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Transferring Data Using an External Storage
Device

You can use the product’s memory card slots or external USB port to copy files to a computer connected to the product.
You can also use it to copy files on your computer to the storage device.

Precautions on Storage Devices

Keep the following in mind when copying files between your storage device and computer:

❏ Check the documentation that came with your storage device and any adapter you may be using for any handling
guidelines.

❏ Do not copy files to a storage device while you are printing from your storage device.

❏ The product display does not update information about your storage device after you copy files to it or delete files
from it. To update the information displayed, eject and reload the storage device.

❏ Do not eject your memory card or turn off the printer while the memory card light is flashing or you may lose
data.

Copying Files Between a Storage Device and Your
Computer

Copying files to your computer

A Make sure the product is turned on and a storage device is inserted or connected.

B Windows 7 and Vista:
Click the start button and select Computer.

Windows XP:
Click Start and select My Computer.

Mac OS X:
The removable disk icon ( ) appears on your desktop automatically.

C Double-click the removable disk icon, then select the folder in which your files are saved.

Note:
If you have set a volume label, it is displayed as the drive name. If you have not set the volume label, “removable disk”
is displayed as the drive name on Windows XP.
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D Select the files you want to copy and drag them to a folder on your computer’s hard drive.

c Important:
For Mac OS X users
When you remove the storage device, always drag the removable disk icon on your desktop into the trash before
you remove the storage device or you may lose data on the device.

Saving files to a storage device

Before inserting your memory card, make sure the write-protect switch is set to allow writing to the memory card.

Note:
After copying a file to a memory card from a Macintosh computer, an older digital camera may not be able to read the
memory card.

A Make sure the product is turned on and a storage device is inserted or connected.

B Windows 7 and Vista:
Click the start button and select Computer.

Windows XP:
Click Start and select My Computer.

Mac OS X:
The removable disk icon ( ) appears on your desktop automatically.

C Double-click the removable disk icon, then select the folder in which you want to save your files.

Note:
If you have set a volume label, it is displayed as the drive name. If you have not set the volume label, “removable disk”
is displayed as the drive name on Windows XP.

D Select the folder on your computer’s hard drive that contains the files you want to copy. Then select the files and
drag them to the folder on your storage device.

c Important:
For Mac OS X users
When you remove the storage device, always drag the removable disk icon on your desktop into the trash before
you remove the storage device or you may lose data on it.
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Error Indicators

Error Messages on the Control Panel

This section describes the meaning of messages displayed on the LCD screen.

Error Messages Solutions

Paper out or Paper jam & See “Paper Jams” on page 139

Printer error. Turn the power off and on again. For details,
see your documentation.

Turn the product off and then back on. Make sure that no paper is
still in the product. If the error message still appears, contact Epson
support.

Communication error. Check if a computer is connected. Make sure the computer is connected correctly. If the error
messages still appears, make sure that scanning software is
installed on your computer and that the software settings are
correct.

The maintenance box is nearing the end of its service life. Replace maintenance box before the end its service life.

& See“Replacing Maintenance Box” on page 126

When the maintenance box is full, the product stops and you need
to replace the maintenance box to continue printing.

The maintenance box is at the end of its service life. You
need to replace it.

Replace the maintenance box.

A printer’s ink pad is nearing the end of its service life.
Please contact Epson Support.

Press x button to resume printing. The message will be displayed
until the ink pad is replaced. Contact Epson support to replace ink
pads before the end of their service life. When the ink pads are
saturated, the product stops and Epson support is required to
continue printing.

A printer’s ink pad is at the end of its service life. Please
contact Epson Support.

Contact Epson support to replace ink pads.

No dial tone detected. Run Check Fax Connection under
Fax Settings in Setup menu.

Make sure the phone cable is connected correctly and the phone
line works.

& See “Connecting to a Phone Line” on page 79

If you connected the product to a PBX (Private Branch Exchange)
phone line or Terminal Adapter, turn off the Dial Tone Detection.
Select Fax Settings > Communication > Dial Tone Detection
>Off.

Combination of the IP address and the subnet mask is
invalid. See your documentation.

Refer the online Network Guide.

Recovery Mode The firmware update has failed. You will need to re-attempt the
firmware update. Ready a USB cable and visit your local Epson
website for further instructions.

     User’s Guide

Error Indicators

135



Troubleshooting for Printing/Copying

Diagnosing the Problem

Troubleshooting product problems is best handled in two steps: first diagnose the problem, then apply likely solutions
until the problem is fixed.

The information that you need to diagnose and solve most common problems is provided by online problem solving,
the control panel, or the status monitor. Refer to the appropriate section below.

If you have a specific problem relating to print quality, a printing problem not related to print quality, or a paper
feeding problem, or if the product does not print at all, refer to the appropriate section.

To solve a problem, you may need to cancel printing.
& “Canceling printing” on page 47
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Checking product status

If a problem occurs while printing, an error message will appear in the status monitor window.

When you need to replace an ink cartridge or a maintenance box, click the How To button on the window, and the
status monitor will lead you step-by-step through the cartridge or the maintenance box replacement procedure.

For Windows

There are two ways to access EPSON Status Monitor 3:

❏ Double-click the product shortcut icon on your Windows taskbar. To add a shortcut icon to the taskbar, see the
following section:
& “From the shortcut icon on the taskbar” on page 43

❏ Open the printer driver, click the Maintenance tab, then click the EPSON Status Monitor 3 button.

When you access EPSON Status Monitor 3, the following window appears:

Note:
❏ If EPSON Status Monitor 3 does not appear, access the printer driver and click the Maintenance tab and then the

Extended Settings button. In the Extended Settings window, check the Enable EPSON Status Monitor 3 check box.

❏ Depending on current settings, the simplified status monitor may be displayed. Click the Details button to display the
window above.

EPSON Status Monitor 3 provides the following information:
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❏ Current Status:
If the ink is low/expended or the maintenance box is nearly full/full, the How to button appears in the EPSON
Status Monitor 3 window. Clicking How to displays ink cartridge or maintenance box replacement instructions.

❏ Ink Levels:
EPSON Status Monitor 3 provides a graphic display of the ink cartridge status.

❏ Information:
You can view information about the installed ink cartridges by clicking Information.

❏ Maintenance Box Service Life:
EPSON Status Monitor 3 provides a graphic display of the maintenance box status.

❏ Technical Support:
Click Technical Support to access the Epson technical support website.

❏ Print Queue:
You can view Windows Spooler by clicking Print Queue.

For Mac OS X

Follow these steps to access EPSON Status Monitor.

A Access the Epson Printer Utility 4.
& “Accessing the printer driver for Mac OS X” on page 43

B Click the EPSON Status Monitor icon. The EPSON Status Monitor appears.
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You can also use this utility to check the ink cartridge status before printing. EPSON Status Monitor displays the ink
cartridge status at the time it was opened. To update the ink cartridge status, click Update.

When ink is low/expended or the maintenance box is nearly full/full, a How to button appears. Click How to, and
EPSON Status Monitor will lead you step by step through the ink cartridge or maintenance box replacement
procedure.

Paper Jams

!Caution:
Never touch the buttons on the control panel while your hand is inside the product.

Note:
❏ Cancel the print job if prompted by a message from the LCD screen or the printer driver.

❏ After you have removed the jammed paper, press the button indicated in the LCD screen.

     User’s Guide

Troubleshooting for Printing/Copying

139



Removing jammed paper from the rear cover

A Pull out the rear cover.

B Carefully remove the jammed paper.
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C Carefully remove the jammed paper.

D Open the rear cover.
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E Carefully remove the jammed paper.

F Reattach the rear cover.

Removing jammed paper from inside the product

A Carefully remove the jammed paper.
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B Open the scanner unit.

c Important:
Do not lift up the scanner unit when the document cover is open.
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C Remove all of the paper inside, including any torn pieces.

c Important:
Do not touch the flat white cable connected to the cartridge holder.

D Close the scanner unit slowly.

Removing jammed paper from the paper cassette

A Pull out the paper cassette.
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Note:
If you cannot pull out the cassette, unplug the power cord from the product and the electrical outlet. Unplug all other
cables from the product.
Carefully stand the product on its side as shown below and carefully pull out the cassette.

B Remove the jammed paper from the cassette.

C Carefully remove any paper jammed inside the product.

D Align the edges of the paper.

E Keep the cassette flat and slowly and carefully reinsert it all the way into the product.
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Removing jammed paper from the Automatic Document Feeder 
(ADF)

A Remove the stack of paper from the ADF input tray.

B Open the ADF cover.

c Important:
Make sure you open the ADF cover before removing jammed paper. If you do not open the cover, the product
may be damaged.

C Carefully remove the jammed paper.

D Close the ADF cover.
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E Open the document cover.

F Carefully remove the jammed paper.

G Close the document cover.

H Raise the ADF input tray.
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I Carefully remove the jammed paper.

J Return the ADF input tray to its original position.

Preventing paper jams

If your paper jams frequently, check the following.

❏ The paper is smooth, not curled or wrinkled.

❏ You are using high-quality paper.

❏ The printable side of the paper is face down in the paper cassette.

❏ The printable side of the paper is face up in the rear paper feed slot.

❏ The paper stack was fanned before loading.

❏ For plain paper, do not load paper above the line just under the H arrow mark inside the edge guide.
For Epson special media, make sure the number of sheets is less than the limit specified for the media.
& “Selecting Paper” on page 20

❏ The edge guides are snug against the edges of the paper.

❏ The product is on a flat, stable surface that extends beyond the base in all directions. The product will not operate
properly if it is tilted.

Reprinting after a paper jam (for Windows only)

After you cancel the print job because of a paper jam, you can reprint it without reprinting pages that have already been
printed.

A Solve the paper jam.
& “Paper Jams” on page 139

B Access the printer settings.
& “Accessing the printer driver for Windows” on page 42
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C Select the Print Preview check box in the Main window of your printer driver.

D Make the settings that you want to use to print.

E Click OK to close the printer settings window, and then print your file. Print Preview window opens.

F Select a page that has already been printed in the page list box on the left side, and then select Remove Page from
the Print Options menu. Repeat this step for all the pages that have already been printed.

G Click Print on the Print Preview window.

Print Quality Help

If you are having print quality problems, then compare it with the illustrations below. Click the caption under the
illustration that best resembles your prints.

Good sample Good sample

& “Horizontal banding” on page 150 & “Vertical banding or misalignment” on
page 150

& “Horizontal banding” on page 150 & “Vertical banding or misalignment” on
page 150
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& “Incorrect or missing colors” on page 151 & “Blurry or smeared print” on page 151

Horizontal banding

❏ Make sure the printable side (the whiter or glossier side) of the paper is face up in the rear paper feed slot.

❏ Make sure the printable side (the whiter or glossier side) of the paper is face down in the paper cassette.

❏ Run the Nozzle Check utility and then clean any print heads which produced a defective nozzle check result.
& “Checking the Print Head Nozzles” on page 117

❏ For best results, use up ink cartridge within six months of opening the package.

❏ Try to use genuine Epson ink cartridges.

❏ Make sure the paper type selected in the LCD menu or printer driver is appropriate for the type of paper loaded in
the product.
& “Selecting Paper” on page 20

❏ If banding appears at intervals of 2.5 cm, run the Print Head Alignment utility.
& “Aligning the Print Head” on page 120

❏ If a moire (cross-hatch) pattern appears on your copy, change the Reduce/Enlarge setting in the LCD menu or
shift the position of your original.

❏ If there is problem with copy quality, clean the exterior of the product.
& “Cleaning the exterior of the product” on page 124

Vertical banding or misalignment

❏ Make sure the printable side (the whiter or glossier side) of the paper is face up in the rear paper feed slot.

❏ Make sure the printable side (the whiter or glossier side) of the paper is face down in the paper cassette.

❏ Run the Nozzle Check utility and then clean any print heads which produced a defective nozzle check result.
& “Checking the Print Head Nozzles” on page 117

❏ Run the Print Head Alignment utility.
& “Aligning the Print Head” on page 120
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❏ For Windows, clear the High Speed check box from the More Options window in your printer driver. See the
online help for details.
For Mac OS X, select Off from the High Speed Printing. To display the High Speed Printing, click through the
following menus: System Preferences, Print & Scan (for Mac OS X 10.7) or Print & Fax (for Mac OS X 10.6 or
10.5), your product (in the Printers list box), Options & Supplies, and then Driver.

❏ Make sure the paper type selected in the LCD menu or printer driver is appropriate for the type of paper loaded in
the product.
& “Selecting Paper” on page 20

❏ If there is problem with copy quality, clean the exterior of the product.
& “Cleaning the exterior of the product” on page 124

Incorrect or missing colors

❏ For Windows, clear the Grayscale setting in the Main window in your printer driver.
For Mac OS X, clear the Grayscale setting in Print Settings in the Print dialog box in your printer driver.
See the online help for details.

❏ Adjust the color settings in your application or in your printer driver settings.
For Windows, check the More Options window.
For Mac OS X, check the Color Options dialog box from the Print dialog box.
See the online help for details.

❏ Run the Nozzle Check utility and then clean any print heads which produced a defective nozzle check result.
& “Checking the Print Head Nozzles” on page 117

❏ If you have just replaced an ink cartridge, make sure the date on the box. If you have not used the product for a long
time, Epson recommends replacing the ink cartridges.
& “Replacing an ink cartridge” on page 114

❏ Try to use genuine Epson ink cartridges and paper recommended by Epson.

Blurry or smeared print

❏ Try to use genuine Epson ink cartridges and paper recommended by Epson.

❏ Make sure the product is on a flat, stable surface that extends beyond the base in all directions. The product will not
operate properly if it is tilted.

❏ Make sure your paper is not damaged, dirty, or too old.

❏ Make sure your paper is dry and the printable side (the whiter or glossier side) is face up in the rear paper feed
slot.

❏ Make sure your paper is dry and the printable side (the whiter or glossier side) is face down in the paper cassette.

❏ If the paper is curled toward the printable side, flatten it or curl it slightly in the opposite direction.

❏ Make sure the paper type selected in the LCD menu or printer driver is appropriate for the type of paper loaded in
the product.
& “Selecting Paper” on page 20
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❏ Remove each sheet from the output tray as it is printed.

❏ Do not touch or allow anything to come into contact with the printed side of paper with a shiny finish. To handle
your prints, follow the instructions of the paper.

❏ Run the Nozzle Check utility and then clean any print heads which produced a defective nozzle check result.
& “Checking the Print Head Nozzles” on page 117

❏ Run the Print Head Alignment utility.
& “Aligning the Print Head” on page 120

❏ If you are printing high-density data on plain paper using automatic 2-sided printing, lower the Print Density and
choose a longer Increased Ink Drying Time in the Print Density Adjustment window (for Windows) or in the
Two-sided Printing Settings (for Mac OS X) of your printer driver.

❏ If the paper is smeared with ink after printing, clean the interior of the product.
& “Cleaning the interior of the product” on page 125

❏ If there is problem with copy quality, clean the exterior of the product.
& “Cleaning the exterior of the product” on page 124

Miscellaneous Printout Problems

Incorrect or garbled characters

❏ Clear any stalled print jobs.
& “Canceling printing” on page 47

❏ Turn off the product and computer. Make sure the product’s interface cable is securely plugged in.

❏ Uninstall the printer driver, then reinstall it.
& “Uninstalling Your Software” on page 130

Incorrect margins

❏ Make sure that the paper is loaded into the rear paper feed slot or the paper cassette correctly.
& “Loading Paper into the Paper Cassette” on page 24 
& “Loading Envelopes into the Paper Cassette” on page 27 
& “Loading Paper and Envelopes into the Rear Paper Feed Slot” on page 31

❏ Check the margin settings in your application. Make sure that the margins are within the printable area of the
page.
& “Printable area” on page 170

❏ Make sure the printer driver settings are appropriate for the paper size you are using.
For Windows, check the Main window.
For Mac OS X, check the Page Setup dialog box or Print dialog box.
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❏ If margins still appear even when printing using the borderless setting, try one of the following. 
For Windows, click Extended Settings button on the printer driver’s Maintenance window, and then select
Remove white borders.
For Mac OS X, select On from the Remove white borders. To display the Remove white borders, click through the
following menus: System Preferences, Print & Scan (for Mac OS X 10.7) or Print & Fax (for Mac OS X 10.6 or
10.5), your printer (in the Printers list box), Options & Supplies, and then Driver.

❏ Uninstall the printer driver, then reinstall it.
& “Uninstalling Your Software” on page 130

Printout has a slight slant

❏ Make sure that the paper is loaded into the rear paper feed slot or the paper cassette correctly.
& “Loading Paper into the Paper Cassette” on page 24 
& “Loading Envelopes into the Paper Cassette” on page 27 
& “Loading Paper and Envelopes into the Rear Paper Feed Slot” on page 31

❏ If Draft is selected in Quality in the Main window in your printer driver (for Windows), or Fast Economy is
selected in Print Quality in Print Settings (for Mac OS X), select another setting.

Size or position of copied image is incorrect

❏ Make sure the paper size, layout, or reduce/enlarge setting selected in the control panel matches the paper used.

❏ If the edges of the copy are cropped off, move the original slightly away from the corner.

❏ Clean the scanner glass.
& “Cleaning the exterior of the product” on page 124

Inverted image

❏ For Windows, clear the Mirror Image check box from the More Options window of your printer driver, or turn
off the Mirror Image setting in your application.
For Mac OS X, clear the Mirror Image check box in Print Settings in the Print dialog box of your printer driver, or
turn off the Mirror Image setting in your application.
For instructions, see the online help for your printer driver or for your application.

❏ Uninstall the printer driver, then reinstall it.
& “Uninstalling Your Software” on page 130

Blank pages print

❏ Make sure the printer driver settings are appropriate for the paper size you are using.
For Windows, check the Main window.
For Mac OS X, check the Page Setup dialog box or Print dialog box.
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❏ For Windows, check the Skip Blank Page setting by clicking the Extended Settings button on the Maintenance
window of the printer driver.
For Mac OS X, select On from the Skip Blank Page. To display the Skip Blank Page, click through the following
menus: System Preferences, Print & Scan (for Mac OS X 10.7) or Print & Fax (for Mac OS X 10.6 or 10.5), your
product (in the Printers list box), Options & Supplies, and then Driver.

❏ Uninstall the printer driver, then reinstall it.
& “Uninstalling Your Software” on page 130

Printed side is smeared or scuffed

❏ If the paper is curled toward the printable side, flatten it or curl it slightly in the opposite direction.

❏ Make several copies without placing a document on the scanner glass.
& “Cleaning the interior of the product” on page 125

❏ Uninstall the printer driver, then reinstall it.
& “Uninstalling Your Software” on page 130

Printing is too slow

❏ Make sure the paper type selected in the LCD menu or printer driver is appropriate for the type of paper loaded in
the product.
& “Selecting Paper” on page 20

❏ For Windows, choose a Quality in the printer driver Main window.
For Mac OS X, choose a lower Print Quality in the Print Settings dialog box from your printer driver’s Print dialog
box.
& “Accessing the printer driver for Windows” on page 42 
& “Accessing the printer driver for Mac OS X” on page 43

❏ Close any unnecessary applications.

❏ If you print continuously for an extended period, the printing may be extremely slow. This is to slow down the
printing speed and prevent the product mechanism from overheating and being damaged. If this happens, you
can continue to print, but we recommend stopping and leaving the product idle for at least 45 minutes with the
power on. (The product does not recover with the power off.) After you restart, the product will print at normal
speed.

❏ Uninstall the printer driver, then reinstall it.
&  “Uninstalling Your Software” on page 130

If you try all of the methods above and cannot solve the problem, see the following:
& “Increasing the Print Speed (For Windows Only)” on page 158

     User’s Guide

Troubleshooting for Printing/Copying

154



Paper Does Not Feed Correctly

Paper does not feed

Remove the stack of paper and make sure of the following:

❏ You have inserted the paper cassette all the way into the product.

❏ The paper is not curled or creased.

❏ The paper is not too old. See the instructions that came with the paper for more information.

❏ For plain paper, do not load paper above the line just under the H arrow mark inside the edge guide.
For Epson special media, make sure the number of sheets is less than the limit specified for the media.
& “Selecting Paper” on page 20

❏ Paper is not jammed inside the product. If it is, remove the jammed paper.
& “Paper Jams” on page 139

❏ The ink cartridges are not expended. If a cartridge is expended, replace it.
& “Replacing an ink cartridge” on page 114

❏ You have followed any special loading instructions that came with your paper.

Multiple pages feed

❏ For plain paper, do not load paper above the line just under the H arrow mark inside the edge guide.
For Epson special media, make sure the number of sheets is less than the limit specified for the media.
& “Selecting Paper” on page 20

❏ Make sure the edge guides are snug against the edges of the paper.

❏ Make sure the paper is not curled or folded. If so, flatten it or curl it slightly toward the opposite side before
loading.

❏ Remove the stack of paper and make sure that the paper is not too thin.
& “Paper” on page 169

❏ Fan the edges of the stack to separate the sheets, then reload the paper.

❏ If too many copies of a file are being printed, check the Copies setting in your printer driver as follows, and also
check in your application.
For Windows, check the Copies setting on the Main window.
Mac OS X, check the Copies setting in the Print dialog.

Paper is improperly loaded

If you have loaded the paper too far into the product, the product cannot feed the paper correctly. Turn the product off
and gently remove the paper. Then turn the product on and reload the paper correctly.

     User’s Guide

Troubleshooting for Printing/Copying

155



Paper is not ejected fully or is wrinkled

❏ If the paper does not eject fully, press one of the x buttons to eject the paper. If the paper is jammed inside the
product, remove it by referring to the following section.
& “Paper Jams” on page 139

❏ If the paper is wrinkled when it comes out, it may be damp or too thin. Load a new stack of paper.

Note:
Store any unused paper in its original packaging in a dry area.

The Product Does Not Print

All lights are off

❏ Press the P button to make sure the product is on.

❏ Make sure that the power cord is securely plugged in.

❏ Make sure that your outlet works and is not controlled by a wall switch or timer.

Lights came on and then went out

The product’s voltage may not match the outlet rating. Turn off the product and unplug it immediately. Then check
the label on the back of the product.

!Caution:
If the voltage does not match, DO NOT PLUG YOUR PRODUCT BACK IN. Contact your dealer.

Only the power light is on

❏ Turn off the product and computer. Make sure the product’s interface cable is securely plugged in.

❏ If you are using the USB interface, make sure your cable meets the USB or Hi-Speed USB standards.

❏ If you are connecting the product to your computer via a USB hub, connect the product to the first-tier hub from
your computer. If the printer driver is still not recognized on your computer, try to directly connect the product to
your computer without the USB hub.

❏ If you are connecting the product to your computer via a USB hub, make sure the USB hub device is recognized by
your computer.

❏ If you are trying to print a large image, your computer may not have enough memory. Try reducing the resolution
of your image or printing the image at a smaller size. You may need to install more memory in your computer.

❏ Users of Windows can clear any stalled print jobs from the Windows Spooler.
& “Canceling printing” on page 47

     User’s Guide

Troubleshooting for Printing/Copying

156



❏ Uninstall the printer driver, then reinstall it.
& “Uninstalling Your Software” on page 130

An ink error is indicated after you replace the cartridge

A Open the scanner unit.

c Important:
Do not lift up the scanner unit when the document cover is open.

B Make sure the ink cartridge holder is at the ink cartridge replacement position.

Note:
If the ink cartridge holder is at the far right position, enter Setup mode from the Home menu , select Maintenance,
and then select Ink Cartridge Replacement.
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C Open the ink cartridge cover. Remove and reinsert the ink cartridge and then continue with the ink cartridge
installation.

D Close the ink cartridge cover firmly.

E Close the scanner unit slowly.

Increasing the Print Speed (For Windows Only)

Print speed may be increased by selecting certain settings in the Extended Settings window when the printing speed is
slow. Click the Extended Settings button on your printer driver’s Maintenance window.
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The following dialog box appears.

Select the following check boxes and print speed may be increased.

❏ High Speed Copies

❏ Always spool RAW datatype

❏ Page Rendering Mode

❏ Print as Bitmap

For more details on each item, see the online help.

Other Problem

Printing plain papers quietly

When plain paper is selected for the paper type and Standard (Windows) or Normal (Mac OS X) is selected as for
quality in the printer driver, the product prints at high speed. Try choosing Quiet Mode for quieter operation which
will reduce the print speed.

For Windows, select the Quiet Mode check box in the Main window of your printer driver.
For Mac OS X, select On from the Quiet Mode. To display the Quiet Mode, click through the following menus: System
Preferences, Print & Scan (for Mac OS X 10.7) or Print & Fax (for Mac OS X 10.6 or 10.5), your product (in the
Printers list box), Options & Supplies, and then Driver.
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Troubleshooting for Scanning

Problems Indicated by Messages on the LCD Screen or
Status Light

❏ Make sure the product is connected to your computer properly.

❏ Turn off the product and turn it on again. If the problem is not solved, the product may be malfunctioning, or the
light source in the scanner unit may need to be replaced. Contact your dealer.

❏ Make sure the scanning software is fully installed.
See the paper manual for instructions on installing the scanning software.

Problems When Starting a Scan

❏ Check the status light and make sure the product is ready to scan.

❏ Make sure your cables are securely connected to the product and a working electrical outlet.
If necessary, test your product’s AC adapter by plugging in another electrical device and turning it on.

❏ Turn off the product and computer, and then check the interface cable connection between them to make sure it is
secure.

❏ Make sure you select the correct product if a scanner list appears when starting to scan.

Windows:
When you start Epson Scan using the EPSON Scan icon, and the Select Scanner list is displayed, make sure you
select the model of your product.

Mac OS X:
When you start Epson Scan from the Applications folder and the Select Scanner list is displayed, make sure you
select the model of your product.

❏ Connect the product directly to the computer’s external USB port or through one USB hub only. The product may
not work properly when connected to the computer through more than one USB hub. If the problem persists, try
connecting the product directly to the computer.

❏ If more than one product is connected to your computer, it may not work. Connect only the product you want to
use, and then try scanning again.

❏ If the scanning software does not work properly, uninstall the software first and then reinstall it as described in the
paper manual.
& “Uninstalling Your Software” on page 130

Using the Automatic Document Feeder (ADF)

❏ If the document cover or ADF cover is open, close it and try scanning again.
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❏ Make sure you have selected either Office Mode or Professional Mode in Epson Scan.

❏ Make sure your cables are securely connected to the product and a working electrical outlet.

Using the button

Note:
Depending on the product, the scanning function may not be available when using the button.

❏ Check if you have assigned a program to the button.
& “Epson Event Manager” on page 77

❏ Make sure Epson Scan and Epson Event Manager are installed correctly.

❏ If you have clicked the Keep Blocking button in the Windows Security Alert window during or after installation of
the Epson Software, unblock Epson Event Manager.
& “How to unblock Epson Event Manager” on page 161

❏ Mac OS X:
Make sure you are logged on as the user who installed the scanning software. Other users must first start Epson
Scanner Monitor in the Applications folder and then press a button to scan.

How to unblock Epson Event Manager

A Click Start or the start button, and then point to Control Panel.

B Do one of the following.

❏ Windows 7:
Select System and Security.

❏ Windows Vista:
Select Security.

❏ Windows XP:
Select Security Center.

C Do one of the following.

❏ Windows 7 and Windows Vista:
Select Allow a program through Windows Firewall.

❏ Windows XP:
Select Windows Firewall.

D Do one of the following.

❏ Windows 7:
Confirm that the check box for EEventManager Application is selected in the Allowed programs and
features list.
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❏ Windows Vista:
Click the Exceptions tab, and then confirm that the check box for EEventManager Application is selected
in the Program or port list.

❏ Windows XP:
Click the Exceptions tab, and then confirm that the check box for EEventManager Application is selected
in the Programs and Services list.

E Click OK.

Using scanning software other than Epson Scan driver

❏ If you are using any TWAIN-compliant programs, such as Adobe Photoshop Elements, make sure that the correct
product is selected as the Scanner or Source setting.

❏ If you cannot scan using any TWAIN-compliant scanning programs, such as Adobe Photoshop Elements,
uninstall the TWAIN-compliant scanning program and then reinstall it.
& “Uninstalling Your Software” on page 130

Problems When Feeding Paper

The paper gets dirty

You may need to clean the product.
& “Cleaning the Product” on page 124

Multiple sheets of paper are fed

❏ If you load unsupported paper, the product may feed more than one sheet of paper at a time.
& “Automatic Document Feeder (ADF) specifications” on page 172

❏ You may need to clean the product.
& “Cleaning the Product” on page 124

The paper jams in the Automatic Document Feeder (ADF) 

Remove the jammed paper inside the ADF.
& “Removing jammed paper from the Automatic Document Feeder (ADF)” on page 146

Problems With Scanning Time

❏ Computers with Hi-Speed external USB ports can scan faster than those with external USB ports. If you are using a
Hi-Speed external USB port with your product, make sure it meets the system requirements.
& “System Requirements” on page 169
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❏ Scanning at a high resolution takes a long time.

Problems With Scanned Images

Scan quality is unsatisfactory

Scan quality can be improved by changing the current settings or adjusting the scanned image.
& “Image Adjustment Features” on page 59

An image on the back of your original appears in your scanned image

If your original is printed on thin paper, images on the back may be visible to the product and appear in your scanned
image. Try scanning the original with a piece of black paper placed on the back of it. Also make sure the Document
Type and Image Type settings are correct for your original.

Characters are distorted or blurred

❏ In Office Mode or Home Mode, select the Text Enhancement check box.

❏ Adjust the Threshold setting.

Home Mode:
Select Black&White as the Image Type setting, click the Brightness button, and then try adjusting the Threshold
setting.

Office Mode:
Select Black&White as the Image Type setting, and then try adjusting the Threshold setting.

Professional Mode:
Select Black & White as the Image Type setting and click the + (Windows) or r (Mac OS X) button next to Image
Type. Make the appropriate Image Option setting and then try adjusting the Threshold setting.

❏ Increase the resolution setting.

Characters are not recognized correctly when converted into editable text
(OCR)

Place the document so that it is straight on the scanner glass. If the document is skewed, it may not be recognized
correctly.

Ripple patterns appear in your scanned image

A ripple or cross-hatch pattern (known as moiré) may appear in a scanned image of a printed document.
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❏ Rotate your original document.

❏ Rotate the scanned image using the application software after scanning.

❏ Select the Descreening check box.

❏ In Professional Mode, change a resolution setting and scan again.

Uneven color, smears, dots, or straight lines appear in your image

You may need to clean the interior of the product.

& “Cleaning the Product” on page 124

The scanning area or direction is unsatisfactory

The edges of your original are not scanned

❏ If you are scanning using thumbnail preview in Home Mode or Professional Mode, move the document or photo
6 mm (0.2 inch) away from the horizontal and vertical edges of the scanner glass to avoid cropping.

❏ If you are scanning using the button or using normal preview in Office Mode, Home Mode, or Professional Mode,
move the document or photo about 3 mm (0.12 inch) away from the horizontal and vertical edges of the scanner
glass to avoid cropping.
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Multiple documents are scanned into a single file

Position documents at least 20 mm (0.8 inch) apart from each other on the scanner glass.

Cannot scan the area you want

Depending on the documents, you may not be able to scan the area you want. Use normal preview in Office Mode,
Home Mode, or Professional Mode and create marquees on the area you want to scan.

Cannot scan in the direction you want

Click Configuration, select the Preview tab, and then clear the Auto Photo Orientation check box. Then, place your
documents correctly.

Problems Remain After Trying All Solutions

If you have tried all the solutions and have not solved the problem, initialize the Epson Scan settings.

Click Configuration, select the Other tab, and then click Reset All.
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Troubleshooting for Faxing

Cannot send and receive fax

❏ Make sure the phone cable is connected correctly and check that the phone line works. You can check the line
status by using the Check Fax Connection function.
& “Connecting to a Phone Line” on page 79

❏ If the fax did not send, make sure that the recipient’s fax machine is turned on and working.

❏ If this product is not connected to a phone and you want to receive faxes automatically, make sure you turn on auto
answer.
& “Receiving Faxes” on page 91

❏ If you connected the product to a DSL phone line, you must install a DSL filter on the line otherwise you cannot
fax. Contact your DSL provider for the necessary filter.

❏ If you connected this product to a PBX (Private Branch Exchange) phone line or Terminal Adapter, turn off Dial
Tone Detection.
& “Setup Mode” on page 101

❏ Transmission speed may be the cause of the problem. Lower the Fax Speed setting.
& “Setup Mode” on page 101

❏ Make sure that ECM is turned on. Color faxes cannot be sent and received when ECM is off.
& “Setup Mode” on page 101

Quality problems (sending)

❏ Clean the scanner glass and Automatic Document Feeder (ADF).
& “Cleaning the exterior of the product” on page 124

❏ If the fax you sent was faint or not clear, change the Resolution (or Quality depending on your model) or
Contrast in the fax settings menu.
& “Fax Mode” on page 98

❏ Make sure that ECM is turned on.
& “Setup Mode” on page 101

Quality problems (receiving)

❏ Make sure that ECM is turned on.
& “Setup Mode” on page 101
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Answering machine cannot answer voice calls

❏ When auto answer is turned on and an answering machine is connected to the same phone line as this product, set
the number of rings to answer for receiving faxes to a higher number than the number of rings for the answering
machine.
& “Receiving Faxes” on page 91

Incorrect time

❏ The clock may run fast/slow or may be reset after a power failure, or the power is left off for a long time. Set the
correct time.
& “Setting/Changing Time and Region” on page 122
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Product Information

Ink and Maintenance Box

Ink cartridges

You can use the following ink cartridges with this product:

Ink cartridge Part numbers

WF-3520
WF-3530
WF-3540

For Australia/New
Zealand
WF-3520
WF-3530
WF-3540

WF-3521
WF-3531
WF-3541

Black T1301
T1291

140
138

143
141

Cyan T1302
T1292

140
138

143
141

Magenta T1303
T1293

140
138

143
141

Yellow T1304
T1294

140
138

143
141

Note:
Not all cartridges are available in all regions.

Color Black, Cyan, Magenta, Yellow

Cartridge life For best results, use up ink cartridge within six months of opening the package.

Temperature Storage:
-20 to 40 °C (-4 to 104 °F)

1 month at 40 °C (104 °F)

Freezing:*
-12 °C (10.4 °F)

* Ink thaws and is usable after approximately 3 hours at 25 °C (77 °F).

Maintenance box 

Your can use the following maintenance box with this product.

Part number

Maintenance Box T6711
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System Requirements

For Windows

System PC Interface

Windows 7 (32-bit, 64-bit), Vista (32-bit, 64-bit), XP SP1 or higher(32-bit), or XP
Professional x64 Edition

Hi-Speed USB

For Mac OS X

System PC Interface

Mac OS X 10.5.8, 10.6.x, 10.7.x Hi-Speed USB

Note:
The UNIX File System (UFS) for Mac OS X is not supported.

Technical Specifications

Note:
Specifications are subject to change without notice.

Printer specifications

Paper path Paper cassette 1 and 2 *, front entry

Rear paper feed slot, top entry

Capacity 27.5 mm for paper cassette 1 and 2 *

0.3 mm for rear paper feed slot

* This cassette may not be available depending on the product.

Paper

Note:
❏ Since the quality of any particular brand or type of paper may be changed by the manufacturer at any time,

Epson cannot attest to the quality of any non-Epson brand or type of paper. Always test samples of paper stock
before purchasing large quantities or printing large jobs.

❏ Poor quality paper may reduce print quality and cause paper jams or other problems. If you encounter
problems, switch to a higher grade of paper.

Single sheets:
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Size A4 210 × 297 mm

10 × 15 cm (4 × 6 in.)

13 × 18 cm (5 × 7 in.)

A6 105 × 148 mm

A5 148 × 210 mm

B5 182 × 257 mm

9 × 13 cm (3.5 × 5 in.)

13 × 20 cm (5 × 8 in.)

20 × 25 cm (8 × 10 in.)

16:9 wide size (102 × 181 mm)

100 × 148 mm

Letter 8 1/2 × 11 in.

Legal 8 1/2 × 14 in.

Paper types Plain paper or special paper distributed by Epson

Thickness
(for plain paper)

0.08 to 0.11 mm (0.003 to 0.004 in.)

Weight
(for plain paper)

64 g/m² (17 lb) to 90 g/m² (24 lb)

Envelopes:

Size Envelope #10 4 1/8 × 9 1/2 in.

Envelope DL 110 × 220 mm

Envelope C4 229 × 324 mm

Envelope C6 114 × 162 mm

Paper types Plain paper

Weight 75 g/m² (20 lb) to 90 g/m² (24 lb) for Envelope #10, DL, and C6

80 g/m² (21 lb) to 100 g/m² (26 lb) for Envelope C4

Printable area

Highlighted portions show printable area.

Single sheets:

Normal Borderless
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Envelopes:

Minimum margin

Media type Single sheets Envelopes (#10/DL/C6) Envelop (C4)

A 3.0 mm (0.12 in.) 3.0 mm (0.12 in.)*1 3.0 mm (0.12 in.)*1

B 3.0 mm (0.12 in.) 5.0 mm (0.20 in.) 10.0 mm (0.40 in.)

C 3.0 mm (0.12 in.) 3.0 mm (0.12 in.)*2 3.0 mm (0.12 in.)*2

*1 The recommended margin is 17 mm.

*2 The recommended margin is 42 mm.

Note:
Depending on the type of paper, print quality may decline in the top and bottom areas of the print, or the area may be
smeared.

Scanner specifications

Scanner type Flatbed color

Photoelectric device CIS
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Effective pixels 10200 × 14040 pixels at 1200 dpi

Scanning area may be restricted if resolution setting is large.

Document size 216 × 297 mm (8.5 × 11.7 inches) A4 or US letter size

Scanning resolution 1200 dpi (main scan)

2400 dpi (sub scan)

Output resolution 50 to 4800, 7200, and 9600 dpi

(50 to 4800 dpi in 1 dpi increments)

Image data 16 bits per pixel per color internal

8 bits per pixel per color external (maximum)

Light source LED

Automatic Document Feeder (ADF) specifications

Paper input Face-up/center loading

Paper output Face-down ejection

Paper size A4, Letter, Legal*

Paper types Plain paper

Paper weight 64 to 95 g/m²

Paper capacity Total thickness of 3 mm, up to about 30 sheets (Letter, A4) 10 sheets (Legal)

* When you scan a 2-sided document using the ADF, the legal size paper is not available.

Fax specifications

Fax type Walk-up black and white and color fax capability

Support line Household phone line

Speed Up to 33.6 kbps

Resolution Monochrome

Standard: 203 × 98 dpi

Fine: 203 × 196 dpi

Photo: 203 × 196 dpi

Color

Fine: 200 × 200 dpi

Photo: 200 × 200 dpi

Error correction mode CCITU/ITU Group 3 fax with error correction mode

Speed dial numbers Up to 100

Page memory Up to 180 pages (ITU-T No.1 chart)
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Redial 2 times (with 1 minute interval)

Interface RJ-11 Phone Line RJ-11 Telephone set connection

Network interface specification

Wi-Fi Standard: IEEE 802.11b/g/n*1

Security: WEP (64/128bit)
WPA-PSK (TKIP/AES) *2

Frequency Band: 2.4 GHz

Communication Mode: Infrastructure mode

Ad hoc mode

Wi-Fi Direct*3

Ethernet Standard: IEEE802.3i/u, IEEE802.3az*4

Communication Mode: Ethernet 100BASE-TX/10BASE-T

*1 Complies with either IEEE 802.11b/g/n or IEEE 802.11b/g depending on location of purchase.

*2 Complies with WPA2 with support for WPA/WPA2 Personal.

*3 Only WP-3540 series is supported.

*4 The connected device should comply with IEEE802.3az.

Memory card

Compatible memory
cards

Memory Stick Duo

Memory Stick PRO Duo

Memory Stick PRO-HG Duo

Memory Stick Micro*

MagicGate Memory Stick Duo

SDXC

SDHC

SD

MultiMediaCard

MMCplus

MMCmobile*

MMCmicro*

miniSDHC*

miniSD*

microSDXC*

microSDHC*

microSD*
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Media format DCF DCF (Design rule for Camera File system) version 1.0 or 2.0 compliant.

All card types standard version compliant.

Voltage Requirements 3.3 v

*  Adapter required.

Photo data specifications

File format JPEG with the Exif Version 2.3 standard

Image size 80 × 80 pixels to 9200 × 9200 pixels

Number of files Up to 9990

Mechanical

WF-3520 series

Dimensions Storage

Width: 449 mm (17.7 inches)

Depth: 417 mm (16.4 inches)

Height: 243 mm (9.6 inches)

Printing*

Width: 449 mm (17.7 inches)

Depth: 560 mm (22.0 inches)

Height: 243 mm (9.6 inches)

Weight Approx. 9.0 kg (19.8 lb) without the ink cartridges and the power cord.

* With the output tray extension extended.

WF-3530 series

Dimensions Storage

Width: 449 mm (17.7 inches)

Depth: 427 mm (16.8 inches)

Height: 308 mm (12.1 inches)

Printing*

Width: 449 mm (17.7 inches)

Depth: 563 mm (22.2 inches)

Height: 308 mm (12.1 inches)

Weight Approx. 10.9 kg (24.0 lb) without the ink cartridges and the power cord.

* With the output tray extension extended.

WF-3540 series
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Dimensions Storage

Width: 449 mm (17.7 inches)

Depth: 427 mm (16.8 inches)

Height: 308 mm (12.1 inches)

Printing*

Width: 449 mm (17.7 inches)

Depth: 563 mm (22.2 inches)

Height: 308 mm (12.1 inches)

Weight Approx. 10.9 kg (24.0 lb) without the ink cartridges and the power cord.

* With the output tray extension extended.

Electrical

WF-3520 series

100-120 V Model 220-240 V Model

Input voltage range 90 to 132 V 198 to 264 V

Rated frequency range 50 to 60 Hz 50 to 60 Hz

Input frequency range 49.5 to 60.5 Hz 49.5 to 60.5 Hz

Rated current 0.7 A 0.35 A

Power consumption Standalone copying Approx. 17 W (ISO/
IEC24712)

Approx. 17 W (ISO/
IEC24712)

Ready mode Approx. 6.2 W Approx. 6.2 W

Sleep mode Approx. 2 W Approx. 2 W

Power off Approx. 0.2 W Approx. 0.3 W

WF-3530 series

100-120 V Model 220-240 V Model

Input voltage range 90 to 132 V 198 to 264 V

Rated frequency range 50 to 60 Hz 50 to 60 Hz

Input frequency range 49.5 to 60.5 Hz 49.5 to 60.5 Hz

Rated current 0.7 A 0.35 A

Power consumption Standalone copying Approx. 17 W (ISO/
IEC24712)

Approx. 17 W (ISO/
IEC24712)

Ready mode Approx. 6.2 W Approx. 6.2 W

Sleep mode Approx. 2 W Approx. 2 W

Power off Approx. 0.2 W Approx. 0.3 W
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WF-3540 series

100-120 V Model 220-240 V Model

Input voltage range 90 to 132 V 198 to 264 V

Rated frequency range 50 to 60 Hz 50 to 60 Hz

Input frequency range 49.5 to 60.5 Hz 49.5 to 60.5 Hz

Rated current 0.7 A 0.35 A

Power consumption Standalone copying Approx. 17 W (ISO/
IEC24712)

Approx. 17 W (ISO/
IEC24712)

Ready mode Approx. 6.2 W Approx. 6.2 W

Sleep mode Approx. 2 W Approx. 2 W

Power off Approx. 0.2 W Approx. 0.3 W

Note:
Check the label on the back of the product for its voltage.

Environmental

Temperature Operation:
10 to 35 °C (50 to 95 °F)

Storage:
-20 to 40 °C (-4 to 104 °F)

1 month at 40 °C (104 °F)

Humidity Operation:*
20 to 80% RH

Storage:*
5 to 85% RH

* Without condensation

Standards and approvals

U.S. model:

Safety UL60950-1
CAN/CSA-C22.2 No.60950-1

EMC FCC Part 15 Subpart B Class B
CAN/CSA-CEI/IEC CISPR 22 Class B

This equipment contains the following wireless module.
Manufacture: Askey Computer Corporation
Type: WLU6117-D69 (RoHS)

     User’s Guide

Product Information

176



This product conforms to Part 15 of the FCC Rules and RSS-210 of the IC Rules. Epson cannot accept responsibility for
any failure to satisfy the protection requirements resulting from a non-recommended modification of the product.
Operation is subject to the following two conditions: (1) this device may not cause harmful interference, and (2) this
device must accept any interference received, including interference that may cause undesired operation of the device.

To prevent radio interference to the licensed service, this device is intended to be operated indoors and away from
windows to provide maximum shielding. Equipment (or its transmit antenna) that is installed outdoors is subject to
licensing.

European model:

Low voltage directive 2006/95/
EC

EN60950-1

EMC directive 2004/108/EC EN55022 Class B
EN61000-3-2
EN61000-3-3
EN55024

R&TTE directive 1999/5/EC EN300 328
EN301 489-1
EN301 489-17
TBR21
EN60950-1

For European users:
We, Seiko Epson Corporation, hereby declare that the equipment Models, C481A, C481B and C481C, are in
compliance with the essential requirements and other relevant provisions of Directive 1999/5/EC.

For use only in Ireland, UK, Austria, Germany, Liechtenstein, Switzerland, France, Belgium, Luxemburg,
Netherlands, Italy, Portugal, Spain, Denmark, Finland, Norway, Sweden, Iceland, Cyprus, Greece, Slovenia, Malta,
Bulgaria, Czech, Estonia, Hungary, Latvia, Lithuania, Poland, Romania, and Slovakia.

Only indoor operation is permitted in France.
If used outside of own premises, general authorization is required in Italy.

Epson can not accept responsibility for any failure to satisfy the protection requirements resulting a
non-recommended modification of the products.

Australian model:

EMC AS/NZS CISPR22 Class B

Epson hereby declares that the equipment Models, C481A, C481B and C481C, are in compliance with the essential
requirements and other relevant provisions of AS/NZS4268. Epson cannot accept responsibility for any failure to
satisfy the protection requirements resulting from a non-recommended modification of the product.

Interface

Hi-Speed USB (Device Class for computers)
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Hi-Speed USB (for PictBridge compliant devices/Mass storage class for external storage)*

* Epson cannot guarantee the operation of externally connected devices.

External USB device

Devices The maximum capacities

CD-R drive*, DVD-R drive*, Blu-ray drive* CD-ROM/CD-R: 700MB
DVD-ROM/DVD-R: 4.7GB
(CD-RW, DVD-RW, DVD+R, DVD+RW and Blu-ray DiscTM are not
supported.)

MO drive* 1.3 GB

Hard disk drive*
USB Flash drive

2 TB
Formatted in FAT, FAT32, or exFAT.

* External storage devices that are powered via USB are not recommended. Use only external storage devices with independent AC
power sources.

Photo data file format DCF (Design rule for Camera File system) version 1.0 or 2.0*
compliant.
* Photo data stored in digital cameras with built-in memory are not
supported.

JPEG with the Exif Version 2.3 standard.
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Where To Get Help

Technical Support Web Site

Epson’s Technical Support Web Site provides help with problems that cannot be solved using the troubleshooting
information in your product documentation. If you have a Web browser and can connect to the Internet, access the site
at:

http://support.epson.net/
http://www.epson.eu/Support (Europe)

If you need the latest drivers, FAQs, manuals, or other downloadables, access the site at:

http://www.epson.com
http://www.epson.eu/Support (Europe)

Then, select the support section of your local Epson Web site.

Contacting Epson Support

Before Contacting Epson

If your Epson product is not operating properly and you cannot solve the problem using the troubleshooting
information in your product documentation, contact Epson support services for assistance. If Epson support for your
area is not listed below, contact the dealer where you purchased your product.

Epson support will be able to help you much more quickly if you give them the following information:

❏ Product serial number
(The serial number label is usually on the back of the product.)

❏ Product model

❏ Product software version
(Click About, Version Info, or similar button in the product software.)

❏ Brand and model of your computer

❏ Your computer operating system name and version

❏ Names and versions of the software applications you normally use with your product

Note:
Depending on the product, the dial list data for fax and/or network settings may be stored in the product’s memory. Due to
breakdown or repair of a product, data and/or settings may be lost. Epson shall not be responsible for the loss of any data, for
backing up or recovering data and/or settings even during a warranty period. We recommend that you make your own
backup data or take notes.
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Help for Users in Europe

Check your Pan-European Warranty Document for information on how to contact Epson support.

Help for Users in Taiwan

Contacts for information, support, and services are:

World Wide Web (http://www.epson.com.tw)

Information on product specifications, drivers for download, and products enquiry are available.

Epson HelpDesk (Phone: +0280242008)

Our HelpDesk team can help you with the following over the phone:

❏ Sales enquiries and product information

❏ Product usage questions or problems

❏ Enquiries on repair service and warranty

Repair service center:

Telephone number Fax number Address

02-23416969 02-23417070 No.20, Beiping E. Rd., Zhongzheng Dist., Taipei City 100,
Taiwan

02-27491234 02-27495955 1F., No.16, Sec. 5, Nanjing E. Rd., Songshan Dist., Taipei City
105, Taiwan

02-32340688 02-32345299 No.1, Ln. 359, Sec. 2, Zhongshan Rd., Zhonghe City, Taipei
County 235, Taiwan

039-605007 039-600969 No.342-1, Guangrong Rd., Luodong Township, Yilan County
265, Taiwan

038-312966 038-312977 No.87, Guolian 2nd Rd., Hualien City, Hualien County 970,
Taiwan

03-2810606 03-2810707 No.413, Huannan Rd., Pingzhen City, Taoyuan County 324,
Taiwan

03-5325077 03-5320092 1F., No.9, Ln. 379, Sec. 1, Jingguo Rd., North Dist., Hsinchu City
300, Taiwan

04-23291388 04-23291338 3F., No.510, Yingcai Rd., West Dist., Taichung City 403, Taiwan

04-23805000 04-23806000 No.530, Sec. 4, Henan Rd., Nantun Dist., Taichung City 408,
Taiwan

05-2784222 05-2784555 No.463, Zhongxiao Rd., East Dist., Chiayi City 600, Taiwan

06-2221666 06-2112555 No.141, Gongyuan N. Rd., North Dist., Tainan City 704, Taiwan

     User’s Guide

Where To Get Help

180

http://www.epson.com.tw


Telephone number Fax number Address

07-5520918 07-5540926 1F., No.337, Minghua Rd., Gushan Dist., Kaohsiung City 804,
Taiwan

07-3222445 07-3218085 No.51, Shandong St., Sanmin Dist., Kaohsiung City 807,
Taiwan

08-7344771 08-7344802 1F., No.113, Shengli Rd., Pingtung City, Pingtung County 900,
Taiwan

Help for Users in Australia

Epson Australia wishes to provide you with a high level of customer service. In addition to your product
documentation, we provide the following sources for obtaining information:

Your Dealer

Don’t forget that your dealer can often help identify and resolve problems. The dealer should always be the first call for
advise on problems; they can often solve problems quickly and easily as well as give advise on the next step to take.

Internet URL http://www.epson.com.au

Access the Epson Australia World Wide Web pages. Worth taking your modem here for the occasional surf! The site
provides a download area for drivers, Epson contact points, new product information and technical support (e-mail).

Epson Helpdesk

Epson Helpdesk is provided as a final backup to make sure our clients have access to advice. Operators on the Helpdesk
can aid you in installing, configuring and operating your Epson product. Our Pre-sales Helpdesk staff can provide
literature on new Epson products and advise where the nearest dealer or service agent is located. Many types of queries
are answered here.

The Helpdesk numbers are:

Phone: 1300 361 054

Fax: (02) 8899 3789

We encourage you to have all the relevant information on hand when you ring. The more information you prepare, the
faster we can help solve the problem. This information includes your Epson product documentation, type of
computer, operating system, application programs, and any information you feel is required.

Help for Users in Singapore

Sources of information, support, and services available from Epson Singapore are:

World Wide Web (http://www.epson.com.sg)

Information on product specifications, drivers for download, Frequently Asked Questions (FAQ), Sales Enquiries,
and Technical Support via e-mail are available.
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Epson HelpDesk (Phone: (65) 6586 3111)

Our HelpDesk team can help you with the following over the phone:

❏ Sales enquiries and product information

❏ Product usage questions or problems

❏ Enquiries on repair service and warranty

Help for Users in Thailand

Contacts for information, support, and services are:

World Wide Web (http://www.epson.co.th)

Information on product specifications, drivers for download, Frequently Asked Questions (FAQ), and e-mail are
available.

Epson Hotline (Phone: (66)2685-9899)

Our Hotline team can help you with the following over the phone:

❏ Sales enquiries and product information

❏ Product usage questions or problems

❏ Enquiries on repair service and warranty

Help for Users in Vietnam

Contacts for information, support, and services are:

Epson Hotline (Phone): 84-8-823-9239

Service Center: 80 Truong Dinh Street, District 1, Hochiminh City
Vietnam

Help for Users in Indonesia

Contacts for information, support, and services are:

World Wide Web (http://www.epson.co.id)

❏ Information on product specifications, drivers for download

❏ Frequently Asked Questions (FAQ), Sales Enquiries, questions through e-mail
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Epson Hotline

❏ Sales enquiries and product information

❏ Technical support

Phone (62) 21-572 4350

Fax (62) 21-572 4357

Epson Service Center

Jakarta Mangga Dua Mall 3rd floor No 3A/B
Jl. Arteri Mangga Dua,
Jakarta

Phone/Fax: (62) 21-62301104

Bandung Lippo Center 8th floor
Jl. Gatot Subroto No.2
Bandung

Phone/Fax: (62) 22-7303766

Surabaya Hitech Mall lt IIB No. 12
Jl. Kusuma Bangsa 116 – 118
Surabaya

Phone: (62) 31-5355035
Fax: (62)31-5477837

Yogyakarta Hotel Natour Garuda
Jl. Malioboro No. 60
Yogyakarta

Phone: (62) 274-565478

Medan Wisma HSBC 4th floor
Jl. Diponegoro No. 11
Medan

Phone/Fax: (62) 61-4516173

Makassar MTC Karebosi Lt. Ill Kav. P7-8
JI. Ahmad Yani No.49
Makassar

Phone: (62)411-350147/411-350148
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Help for Users in Hong Kong

To obtain technical support as well as other after-sales services, users are welcome to contact Epson Hong Kong
Limited.

Internet Home Page

Epson Hong Kong has established a local home page in both Chinese and English on the Internet to provide users with
the following information:

❏ Product information

❏ Answers to Frequently Asked Questions (FAQs)

❏ Latest versions of Epson product drivers

Users can access our World Wide Web home page at:

http://www.epson.com.hk

Technical Support Hotline

You can also contact our technical staff at the following telephone and fax numbers:

Phone: (852) 2827-8911

Fax: (852) 2827-4383

Help for Users in Malaysia

Contacts for information, support, and services are:

World Wide Web (http://www.epson.com.my)

❏ Information on product specifications, drivers for download

❏ Frequently Asked Questions (FAQ), Sales Enquiries, questions through e-mail

Epson Trading (M) Sdn. Bhd.

Head Office.

Phone: 603-56288288

Fax: 603-56288388/399
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Epson Helpdesk
❏ Sales enquiries and product information (Infoline)

Phone: 603-56288222

❏ Enquiries on repair services & warranty, product usage and technical support (Techline)

Phone: 603-56288333

Help for Users in India

Contacts for information, support, and services are:

World Wide Web (http://www.epson.co.in)

Information on product specifications, drivers for download, and products enquiry are available.
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Epson India Head Office - Bangalore

Phone: 080-30515000

Fax: 30515005

Epson India Regional Offices:

Location Telephone number Fax number

Mumbai 022-28261515 /16/17 022-28257287

Delhi 011-30615000 011-30615005

Chennai 044-30277500 044-30277575

Kolkata 033-22831589 / 90 033-22831591

Hyderabad 040-66331738/ 39 040-66328633

Cochin 0484-2357950 0484-2357950

Coimbatore 0422-2380002 NA

Pune 020-30286000 /30286001/30286002 020-30286000

Ahmedabad 079-26407176 / 77 079-26407347

Helpline

For Service, Product info or to order a cartridge - 18004250011 (9AM - 9PM) - This is a Toll-free number.

For Service (CDMA & Mobile Users) - 3900 1600 (9AM - 6PM) Prefix local STD code

Help for Users in the Philippines

To obtain technical support as well as other after sales services, users are welcome to contact the Epson Philippines
Corporation at the telephone and fax numbers and e-mail address below:

Trunk Line: (63-2) 706 2609

Fax: (63-2) 706 2665

Helpdesk Direct Line: (63-2) 706 2625

E-mail: epchelpdesk@epc.epson.com.ph

World Wide Web (http://www.epson.com.ph)

Information on product specifications, drivers for download, Frequently Asked Questions (FAQ), and E-mail
Enquiries are available.

Toll-Free No. 1800-1069-EPSON(37766)
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Our Hotline team can help you with the following over the phone:

❏ Sales enquiries and product information

❏ Product usage questions or problems

❏ Enquiries on repair service and warranty
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